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The Synthesis Platform
Guide

Thank you for your interest in the Synthesis Platform. This guide demonstrates some of the opportunities
for integration between Synthesis applications.

We will ask you to imagine that you are designing and building a new product, then discuss the steps you
might take in the various Synthesis applications. Please note that the sample data sets provided are
fictional and intended for demonstration purposes. Furthermore, note that this guide shows only some of
the many analysis and integration capabilities in the Synthesis Platform. Within each application, you can
choose File > Help to access a wide array of resources that will help you explore other software
capabilities.

This guide is intended to show a possible workflow that is enabled by the integration among the Synthesis
applications. For this reason, step-by-step instructions are not provided for most of the tasks; instead, a
higher-level discussion is given. The guide will refer to sample projects in the example database that is
installed with the software (called “Synthesis9 _Guide Revl.rsgz9”) to allow you to view the relevant
parts of the analysis. To access the file, choose File > Help in any Synthesis desktop application, click
Open Examples Folder, then browse for the file in the Synthesis sub-folder.

Examples

: Open Examples Folder

Quick Start Guide

Q

Tip: To preserve the integrity of the shipped example files, the software creates a copy of the file each time you
access a repository in the Examples folder. The copy has the same name as the original file and is saved in the
default documents folder for your computer (e.g., My Documents\ReliaSoft\Files). Use the copy to work on the
example projects and save your changes. Any changes you make in the copy will not affect the original file.
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1 The Synthesis Platform Guide

At various times, you will need to open the sample projects in different Synthesis applications. These
transitions are marked in the guide with the application’s icon. The simplest way to open the current
project in another Synthesis application is to click the Another Synthesis Application icon in the Quick
Access Toolbar at the top of the window, and choose the application from the list.

2 (O & -z

(‘ BlockSim

@ RGA
® REND
@ Lambda Predict

(:) DOE++

Also note that many of the steps in this guide can be performed in Xfmea, RCM++ or RBI. All
screenshots for these steps show the RCM++ interface, so if you are working in Xfmea or RBI, your
interface may look slightly different from what is shown in the guide.

If you have not purchased licenses for all of the applications used in this guide, you can activate free,
expiring demos of the unlicensed applications via the Synthesis installation.

IMPORTANT: Note that it may sometimes be necessary to modify the data in the quick start repository to fit
updated instructions or new examples in the latest printing of this quick start guide. This printing of the guide was
designed for use with Synthesis9_Guide_Rev1.rsgz9 (where _RevX indicates the database revision). If you try to
use a different database revision, the sample projects may not exactly match the instructions printed here. 1) If
this guide is older than the latest database revision installed on your computer, you can choose File > Help >
Quick Start Guide to download the latest printing. 2) If this guide is newer than the latest database revision
installed on your computer, you can choose File > Help > Check for Update to download the latest software
service release.
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Sharing Information via

Synthesis Resources

The Synthesis Platform is intended to facilitate data sharing between different reliability engineering
activities, so that the information produced by an analysis performed in one application is available for use
in others. As a very simple example, let’s say you have a data set from testing Component A. You use
Weibull++ to analyze the data set. Then another engineer (let’s call her Karen) wants to analyze the
reliability and maintainability of a system that incorporates Component A. It makes sense for Karen to use
the results from your life data analysis in the reliability block diagram (RBD) that she builds in BlockSim.

Weibull++ Life Data Analysis

= Component A

A30
State Time to Subset
Fors | Fors | 5]
1 F 245
2 F 535
3 F 793
4 F 939
3 F 962
(&} F 1316
7 F 137
g F 1379
9 F 1447
10 F 1451
11 F 1972
12 F 1982
13 =1 1999
14 S 2000
15 =1 2000
16 S 2000
17 =1 2000
13 S 2000
19 =1 2000
20 S 2000
21
22
23
Test 1

BlockSim RBD

Simulation l

S Simulation =
| Results valid as of
'% 8/9/2013 1:13:31 PM

QCP|
¢| “S | Distribution fit

o Mot Fitted
RED

Number of Blacks a

Created

Karen Enginesr

Date [2tz0fzo14

Time [1z:50PM

Modified

Karen Enginesr

Date [2tz0fzo14

Time [1z:50PM

"

S|

& | E | =

n
5l

CP

Lt Analysis Settings
e RRY I B
= FH | MED!
= F=12/5=8

[ %)

= Analysis Summary
W

Parameters

| Bt 1644765
| etatin 2257585661
| Other

jun |

=3[ Rho 0.982623
P \LK value -103.777482 /
=] Main

[ analysis
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2 Sharing Information via Synthesis Resources

The Synthesis Platform achieves this sort of integration via a concept pioneered by ReliaSoft, called
object-based reliability modeling (OBRM). The objects, called Synthesis resources, encapsulate
information in ways that make it easy to share between Synthesis applications, while shielding the
underlying details from view when they’re not needed.

OBRM does not require the recipient to possess a subject matter expertise in the activity that is providing
the information. That is, it hides activity-specific complexity and presents the information in a way that
can easily be used in other contexts. Going back to our simple example: When Karen needs to use
Component A’s reliability information in her BlockSim RBD, she doesn’t need to see the underlying data
set. She just wants to be able to use the results of the Weibull++ analysis to describe the component’s
reliability.

At the same time, if the underlying data changes, it is important to be able to update the information
everywhere that it’s used. Let’s say you discover an error in your Weibull++ data set. When you reanalyze
the data, you need to make sure that the corrected result is used when Karen resimulates the BlockSim
RBD.

The Synthesis resource used for the reliability information in our example is called a model. Once you
have analyzed the data set in Weibull++, you can publish the results as a model.

=S
A40 I Publishing 1
State Time to Subset = STANDARD FoLIO
Fors Fars (5] —
1 F 245 -
2 F 535 ; Weibull_Component A_Test 1
3 F 793 7Y Status Published
e = 539 . Linked? Inlise
5 % View Mode M ] ;
& - e Synchronized? Synchronized
7 Model Basis & Status = Created By Relisbility Engineer
g Source Component &) Test 1 B | modified By Reliability Engineer
9 Application Weibull4++
10 Type Standard Folio
11 Status Synchronized
1; Model Definition
14 2P-weibull
15 Beta 1.644765
15 Eta 2257 585661
17 Priz 1.000000
18 Unit Hour
19 Model Category Relishility
20 ﬂ Identifiers 3] Main
21 N 7
Mame ‘weibull_Component A_Test 1
= = Analysis
gg % Mumber “H
Test 1 E Version EE a; =
> applies to
0N Keywords
s Used by 1 item m @_ Close
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2 Sharing Information via Synthesis Resources

Karen can then associate that model with the block representing Component A in the BlockSim RBD.

& Block Properties ™

Properties Universal Reliability Definition (URD})

=1 @ Block (Standard Block) & =B URD lComponent A_URD |
|—Block name |A | G“ Model - Reliability ‘eibul_Companent A_Test 1 __-_\
i P [Hr] [WEBZ {1.645, 2,255E+03)] i

|—‘r’.z|’ Comective Task  Default - Cannot Be Repaired

#| £ Operation =
B 242 Scheduled Tasks

#| % Consequential Costs L
= Mo scheduled mainkenance tasks are selected.
# i Maintenance Group

21 {p State Change Triggers

| -T_,’— Throughput

=+ EE| Identifiers
)
%t Hierarchy 34 Filkered
Active Block Block 1 > Skyle ﬂ :H _H _@_ @_ Ok Cancel

M L) ©BLockSM @ RENO

Editing block properties

When you update and reanalyze the Weibull++ data set, you simply republish the model, and the new
results are automatically used the next time Karen simulates the RBD.

There are several types of Synthesis resources, each used to share a specific kind of information. In this
guide, you will encounter the following types:

o Universal reliability definitions (URDs) are used to gather together all of the reliability and
maintenance characteristics for a particular component or assembly. This can include reliability
models as well as corrective and/or scheduled maintenance tasks.

e Models can represent probabilities, durations or costs. Any of these values can be either fixed
(constant) or time-dependent. Models are used in a variety of ways — to represent an item’s
reliability, the duration of a task, the costs associated with a crew, etc. They can be created
manually or published from analyses in a variety of Synthesis applications.

e Tasks represent maintenance activities. There are two basic kinds of tasks: Corrective tasks are
unplanned maintenance activities that are performed when a failure occurs and is discovered.
Scheduled tasks include preventive maintenance activities, inspections and on condition
maintenance activities.

o Crews represent the labor personnel who will perform the maintenance activity, including the
availability of the personnel and the time and costs associated with the labor.

o Spare part pools are used to describe the conditions that determine whether a spare part will
be available when needed for a particular maintenance activity, and to specify the time and
costs associated with obtaining the spare part.
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2 Sharing Information via Synthesis Resources

Each application provides the tools you need to create or use Synthesis resources when applicable. For
example, you can quickly and easily publish a model from an analyzed data set using the Publishing page
in a Weibull++, ALTA or RGA folio’s control panel.

Publishing

4

STANDARD FOLIO

Publishing

a
m Model Name Model Category
: Wweibull_Component A_Test 1 Reliability e
=
Source Foliol/Datal
Application Weibull++
Type Standard Folio
Status Synchronized
2P-weibull
Beta 1.644765
Eta 2257.5585661
Pnz 1.000000
0 Lnit Hour
) Main ﬁ -
0
JH Analysig T Murnber
|- Version
2 Applies ta
6 Keywords
] [0]4 Cancel

Unpublished
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2 Sharing Information via Synthesis Resources

Likewise, the Block Properties window in BlockSim and the Reliability Policy node in Xfmea/RCM++/

RBI make it easy to select existing URDs/models or create them on the fly.

& Block Properties

g Properties Universal Reliability Definition (URD)
i =1 @ Block (Standard Block) t = ® URD Default e
r |— Block name A |_ Model - p
@ B h Reliabiliy Default - Cannot Fail D‘
Block description — "5'
Model
b3 B % Operation F = 2
[ﬁ |—|_ Set block as Failed Filter =
X
|_|— Represents mulkiple blacks ._._? ALTA_Component C_Test 1 [ARW (3,526, 1
R Component B [WEZ {1,046, 865.737)]
|— Current age 0{Hr 3
m L @ Component 0 [0,937]
= Duty cycle ! § R&A_Component E_Data 1 [Ex1 (7.603)]
~ = $ Consequential Costs j Weibull_Component A_Test 1 [WEZ {1,645,
2[5 1dentifiers it ET
Active Block Block 1 el | Style | ,Q é’, lé,l ,@ l;Ll
KN D]
Editing block properties I
|ll,| [0]4 Cancel
™ System 1 - = M
A system Hierarchy | EﬂFMRA L j Properties |
Property Name Yalue
Name
#| Item
=l @l System 1 +| Operation
—E Component & #| Rehiability / Availability
—E Component B =l Reliability Pobcy
—E Component Type Define at this level -
_E Companent D =l URD Default (Mot Set) ann
_E Campanent E {@ Model |DeFauIt-Cann0t Fail ILIJI
E 27 Carrective Task E=E
E Component F . &a Model LEILEILEJ
—E Cormponent G #| History 4 _—
Filter | =1
—E Component H
? ALTA_Component C_Test 1 [ARW (3,526, 1
_._? Component B [WEZ (1,046, 868.737)]
@ Component 0 [0,937]
1 ¥ RGA_Component E_Data 1 [EX1 {0.132)]
q ] Item 4 -
j ‘weibull_Component A_Test 1 [WEBZ (1,645,
K 2
& Ok Cancel
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2 Sharing Information via Synthesis Resources

In addition, all of these applications provide access to the Resource Manager (Project > Synthesis >

Resource Manager), where you can view and manage all of the resources available for the current project
in the current application.

Home Administration

=i __‘_ g .l'/ IJ ;: . | 34 Display Autn Filter Row | E [ sdd Ttems

7 Enable Advanced Filters

Print Mew Wiew Delste Duplicate Refresh Trace Make Global Calumn | Kumber ko Add
| Usage | a Show All Resources - chooser | |
e Edic ull s Filter ' J
Resources
| . . Model i
Madel Mame Distribution Madel Linik Farameter 1 Farameter 2
(R URDs Categary
L I I | I | |
P Variables =
E —
| L/ Models | \i‘WeibuH_CumpunEnt A_Test 1 Hour {Hr}
{f Corrective Tasks QIALT.LComDUnEnt C_Test1 arrhenius-weibul Refiabiity — Hour (Hry  3.52618985789107  161,426888678245
%_—;_ Scheduled Tasks liICﬂmpnnervl: B 2ZP-weibull Relisbilty  Hour {(Hr) 1.04574852700654 868, 737203551953
(i Task Packages Q‘ Component D Fixed Relisbility  Reliabilty  Hour {Hr) 0,937 1]
# Crewms @RGR_Component E_Data 1 1P-Exponential  Reliability Hour {Hr) 0,131533218791303 Nfa

['= spare Part Pools

£

E. Maintenance Groups ]

[ Resources

g Columns

| s 33 | 24

By default, resources are available for use in all analyses in the project (e.g., a model published from an
analysis in ALTA can be applied to an FMEA cause in Xfmea, an event in a BlockSim fault tree, and so
on). You also have the option to make some resources “global” so they are available for use in different
projects throughout the entire database, as shown for the Component D model in the image above.
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Using the Synthesis
Platform

The best way to illustrate how the Synthesis applications can
be used together is by looking at an example. This specific
example is based on a Design for Reliability (DFR)
approach.

You are forming a new company, Chandeliers-R-Us. For
your first product, you are designing and building a single-
light pe.ndant. chagdeller: Yog intend t.o sell this chandelier ‘r\ e make your WOT .S}] nel
for use in residential settings in the United States.

Home of the Reliable Chandelier |

Because this is a new product and the first development
project within the organization, neither knowledge nor data yet exist regarding the reliability of the
proposed product or any of its components.

The following sections describe some of the reliability activities that your team will perform during
product development, and they demonstrate how the Synthesis Platform facilitates and coordinates these
activities.

The Synthesis Platform Guide 9



3 Using the Synthesis Platform

3.1 Create the DFR Plan

@ @ In this section, you will work with the “1. Chandelier - Preliminary Work” project in the quick
start repository, using Xfmea, RCM++ or RBI.

The DFR process involves a series of logical stages that take you from the concept phase through design,
development and testing, manufacturing and support.

s Assemble i : Sy Knowledee Update
5 Khoilads 1z pe & ge Knowledge Khawleda &

S
f AsSESS N
Design Reliability

Development & Testing Manufacturing Support

¥ MONITOR
Field Reliability

" DELIVER
Target Reliability

DEFINE
Reliability Objectives

Concept

<

i % - P
e v @ ) Relizbility Allocation Qb C 0 ‘/Q
| f“) Baseline Reliability 0 ; @@ 4
® © s O APID <
. & ik sy & r:> - 26 &
/. @ “ (e \ System Testing
‘I‘/$ (&) DFMEA ("‘u Sub system Testing 00
('"‘l Cha Point Analysis . \ Reliability Growth Q 'ﬁ Warranty

| l B :
\'
p, ||
- 1l (©) Environment & Usage (‘ (®) component Testing (@) Field Testing

(&) Existing Data/Knowledge b
©

il

= PE
(@) DER Plan FRACAS (©) PFMEA
=)

Your first task is to create a new project in a Synthesis repository to store all of the information and
analyses that your team will compile/perform for the new single-light pendant chandelier.
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3.1 Create the DFR Plan

You create the project in Xfmea/RCM++/RBI and set the project properties as shown next. (To view the
properties for the sample project that has already been created, choose Project > Management > Edit
Project Properties.)

% Edit Project Properties (Project: 1. Chandelier - Prelimitiary Work)

General | Global Identifiers | Configurable Settings |

Mame

|1. Chandelier - Prefiminary Wark,

Description

First steps in the example, Creating the DFR planner, gathering existing data, defining refiability
ohjectives,

Remarks

Proprietary Label
|2014 ReliaSoft Corp, ALL RIGHTS RESERVED

FMEA Structure Select Profile from Library

|Gr0uped Effects and Causes -l-' |[Based on RS DFR Focus]

Project Cateqgary

|N0t Categorized

SYNTHESIS

A

Project Owner: ReliaSoft Corporation
Last Updated: 3/4/2014 12:54 PM  User: ReliaSoft Corporation

For the FMEA Structure, you choose Grouped Effects and Causes. With this setting, all cause and
effect records in the FMEAs will be displayed at the same level of the hierarchy under the failure mode
that they are both associated with. For the configurable settings (e.g., the questions that will be used for
risk discovery analysis, the rating scales used to calculate Risk Priority Numbers, etc.), you use the
predefined RS DFR Focus profile that is installed with the software.

The Synthesis Platform Guide 11



3 Using the Synthesis Platform

The next task is to create the first item in the System Hierarchy and start defining its characteristics in the
Properties tab of the Analysis panel, as shown next.

1. Chandelier = Preliminary Work

‘ System Hierarchy j Properties

Name Property Name

lall Chandelier El Ttem
Image

Ttem Mame Chandelier

Reference Number
Part Mumber 1001

Item Description MMain Chandelier
Remarks This is our first attempt at building one.

Supplier Manufactured in-house

J Item

Then you add a DFR plan for this item. The DFR Planner uses gates and actions to represent the stages of
the DFR process. You use the “DFR Template2 - Basic Plan” template that is shipped with the software as
a starting point, then adapt it to fit your team's specific needs for this project.

The DFR Planner allows you to define gates and sub-gates to track and manage the steps in your process
plan. It also allows you to incorporate actions (either from the FMEA or defined separately) that are
assigned to specific individuals.

To see how your team’s plan for the chandelier looks after the first few gates have been completed, view
the DFR Planner tab in the Analysis panel. You will notice that certain properties of higher-level gates
(e.g., the status and due date) are determined by the properties of their dependent gates and/or actions. For
example, the “Define Reliability Objectives” gate was automatically marked as complete when all three of

12 The Synthesis Platform Guide



3.1 Create the DFR Plan

its dependents were completed. In this way, the tool monitors how the progress of individual activities
relates to the completion of the entire DFR process.

Note: To ensure that you will be able to see some of the “status” functionality that is built into the software, this
example uses a date that is far in the future. By using a future date, the statuses for incomplete gates/actions show
as “Not Started” (rather than “Overdue”), which is more likely to appear in a new plan.

j Froperties a DFR Planner

Selected item only Selected item and dependents
Name @ Status = Start Date Due Date Complction
Date
_______ @ Create the DFR Plan ) F1EE022 H19fE0EE 319/2022
’ Gather Existing Datafknowledge @ J 319jz2022 3fz1jz0z2z 3fz1jz0z2z

=l ’ Define Reliability Objectives
|—_/ Enviranment & Usage
_ll-pp Requirements & Goals
(=3 . .
| Target Estimation
=l ’ Assess Design Reliability
|—_/ Change PaintRisk Discovery
=

3f21f2022 | 4j5fz0ze Bjezfe0zz
3f21f2022 | 3jeaje0zz | ajR1fe0z2
3f23f2022 | 4jzfe0ze | Bjezfanze
3f23f2022 | 3jedfe0zz | Bjezfa0z
4fsjz0zz | 4jzafenzz
4/5j2022 4f6jz022

DFMEA afejzizz  4j10/2022

_ Risk & Safety Analysis 410/2022 H12/2022

1B, FMRA 4f1zj2022  4/18j2022

| Ho create rma aiiziznze | 4132022

| L vetrnma 4320z 4gisj20ze

|—_/ Compute Baseline Reliability 4182022 4232022

=B 1dentify Reliability Gaps 4j23jz02z  4j26i2022
L

_» Reliability Allocation

=l ’ Development

4f23f2022 | 4j26/2022
4fz6fz022 | 7j27iE0z2

_ hehehehehel el el el el el el el el el el el e ol ol el ol ol SRR

H» SetUpFRACAS 4jegiz0zz | 4eEiz0zE
—_» Component Testing 4282022 5fzajz02z
. Reliability Growth Monitoring 4282022 Fleriznzz
. Subsystem Testing 5fzajz02z 6272022
' System Testing 6712022 FiFlznzz
;l’ Manufacture & Deploy Fleriznzz 11/4/z022
. PRMEA FleFiziz: | 7la0fz0zE
.+ Maintenance Planning 7lanjz0zz aj4fz022
L[ Field Testing 9j30fz0zz  10{30/2022
=l ’ Monitor Field Returns 11/4/z022 342023
|—_/ FRACAS 14fz0ee | 1142022
|—_/ ‘Warranky 11/4/z022 342023
] Hierarichy Plot
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3 Using the Synthesis Platform

3.2 Gather Existing Data/Knowledge

C) q::) In this section, you will continue working with the “1. Chandelier - Preliminary Work” project in
the quick start repository, using Xfmea/RCM++/RBI.

The next gate in the DFR plan is to gather (or at least identify) the information that you will need for
subsequent activities. This would include information such as use stress conditions, competing products,
material properties, etc. If similar designs exist, FRACAS data regarding observed failure modes,
occurrence rates, etc. are also invaluable.

You can attach the information that you gather to the DFR planner, either by linking to web pages or files,
or by storing a copy of the file in the database. For the chandelier, your team attaches four items to the
“Gather Existing Data/Knowledge” gate in the planner. They are accessible by double-clicking the
Attachments icon, as shown next.

b Gather Existing/Data Knowledge /@ ‘_/. 3f19jz2022 3fz1jz022 3fz1jz022

Name Type Extension Address Description

E Competitor & LRL htkp: i, muranoimports, comny Competitor &'s website

(1) hitp: ialsengi
P v, materialsengineer , com/ . . .
= . y o - Owerview of steel material properties and the
ﬂ Steel Properties URL goséizlriiapt:?iertles o effects of various heat treatments
T Temperature and y Information on temperature and huridity in
i
o i Hurnidity Data,xlsx Erbedded File s warious Morth American locations
2 Information on the stresses that are likely b
ﬂ ' v to
6 j Usage Stresses.pptx  Embedded File ppkx affect the chandelier during use
<« [EARPERE =] Close

3.3 Identify the Use Conditions

Q) @ In this section, you will continue working with the “1. Chandelier - Preliminary Work” project in
the quick start repository, using Xfmea/RCM++/RBI.

Establishing the limits on the environmental and use conditions is one of the most important elements of
the DFR process. In the case of the chandelier, this is fairly simple, as the product is intended for use in
residential settings in North America. Based on the knowledge gathered for the “Gather Existing Data/

14 The Synthesis Platform Guide



3.4 Set Reliability Requirements

Knowledge” gate, you return to the Properties tab and set the environmental conditions as shown next.
This information will be used during the FMEA and test design.

j Properties a DFR. Planner
Property Name Yalue
=l Item
Ttem Mame Chandelier

Reference Number

Part Mumber 1001

Item Description MMain Chandelier

Remarks This is our first attempt at building one.,
Supplier Manufactured in-house

range of 25%: to 95%:. Yoltage fluctuations from

Environmental Conditions /" Residential use, Stable temperature, Humidity
121 W0 129V,

#| Dperation

#| Reliability / Avail abity
#| Reliability Polcy

#| History

T item

3.4 Set Reliability Requirements

® o l" @ In this section, you will continue working with the “1. Chandelier - Preliminary Work”

project in the quick start repository. Some of the steps are performed in Weibull++ and
some in Xfmea/RCM++/RBI.

Your next step is to set high-level reliability requirements. Depending on the industry and application,
these could be driven by any of a number of factors, such as OEM specifications, marketing/customer
needs, benchmarking specifications, best practices, costs, safety/regulatory concerns, contract
requirements, etc.

For the chandelier, the team decides to use a cost-based approach.

The Synthesis Platform Guide 15



3 Using the Synthesis Platform

O weBULL++
You open the Synthesis Launcher from the Quick Access Toolbar to open the same project in Weibull++.
(This feature can also be accessed by choosing File > Launch Application or Home > Launch >

Another Synthesis Application.)

(‘ BlockSim

@ RGA
® REND
@ Lambda Predict

O DOE++

Then you open the Target Reliability tool and use the settings shown next (“Chandelier Target
Reliability” in the sample project). The table at the top of the window contains the team’s inputs for the
best, worst and most likely scenarios, while the plot shows the Cost vs. Reliability curves calculated based

on those inputs.
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3.4 Set Reliability Requirements

Pointing to the Minimum Cost line in the plot, you see that the minimum cost is reached at a reliability of
95.7958%.

w Chandelier Target Reliability

Target Estimation Inputs

Estimate each scenario with the below factors: Best Most likely Worst
Expected Failuresfreturns per period {as % of sales) & 7 15 )
% of market share you expect to capture a0 a0 g / ‘ |Analysis Details, .. .:.| ‘
Average unit sales price 50 50 50 |
lgﬁ Plot Settings (7]
Average cost per unit ko produce 36 26 22 @
Other cosks per Failure (in addition ko replacement cosk) il il 1] /: |C°5t vs. Reliability -l-'
?(- Keep Aspect Ratio
Only Show Positive Values
Cost vs. Reliability Scaling
Cost Curves
o ; ey r—— 000000
o ;ﬁﬂgﬁt\"%ﬂﬂﬂ ¥ [3000000 | |b 0000 |
— Minirmem Cost € 0.957958 % |i.'J_'_-?:':'- | |i.'J.9'f".’-.‘ |
4.600E206
Show Plot Items
¥ Praduction Cost
¥ Unreliability Cost
4.200E+ 06 ¥ Tatal Cost
| Minimum Cost @ 0.957958 ¥ Minirum Cost
Py |_Max. Market Potential {Units) |
‘ 100000 |
JAQ0E+06
0008 e 0.600 0.850 0.89% 0,943 0,999
Reliability

Based on this, the team decides on a target reliability of 95% for 5,000 hours of operation.
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© XFvMEA @ RCM++ O RBI

You return to Xfmea/RCM++/RBI by clicking its icon in the Windows taskbar and enter these values on
the Properties tab, as shown next. For other fields, default settings are kept.

j Properties a DFR. Planner

Property Name Yalue
#| Item
=| Dperation
Operating Time
Current Age 0{Hr
Duty Cycle 1

Maintenance Group
=l Reliability / Availabiity

Target Reliability

Current Reliability Mot Calrated
Target Availability 0,99
Current Availability Mot Calrated
#| Reliability Polcy
#| History

J Item

3.5 Risk Discovery

0 t‘“ In this section, you will switch to the “2. Chandelier - Assess Design Reliability” project in the
‘) quick start repository, while still using Xfmea/RCM++/RBI.

With the target reliability specified, you can now take a closer look at the system. The basic design of the
chandelier consists of the Frame, Wiring, and Bulb and Socket assemblies. In Xfmea/RCM++/RBI, you

add assemblies and components to the system hierarchy, as shown next.

=ll@ll Chandelier
|—8 Frame
|—8 Wiring
_ll-a Bulb and Socket

L1 Bub
LJ Sockst

At this point, you begin to consider the issue of risk for the system. The purpose of this is to identify the
critical items to focus on; you should perform FMEAs for these items.

For situations in which a prior design exists, the team might perform a change point analysis to assess
what has changed in the new version. For items that have no changes and have performed satisfactorily in
the prior design, further analysis may not be warranted. However, changes that can affect reliability may
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constitute a risk that requires further attention, such as:

Change in the design.

Change in the manufacturer.

Change in the supplier, supplier design or process.
Change in the usage environment.

Change in the system - interface points.

Change in the system - upstream and downstream parts.

Change in the specification.
Change in the performance requirements.

Any other changes that can affect reliability.

Likewise, a similar set of assessment criteria can be applied to evaluate the risk in a new design.

Your team uses the configurable Risk Discovery feature in Xfmea/RCM++/RBI to perform separate
analyses for four items in the system hierarchy: Frame, Wiring, Bulb and Socket. The specific questions
used in this project are based on the “RS DFR Focus” profile that is installed with the software; they are
suitable to consider either changes from a prior design or potential concerns with a new design (as is the
case for this chandelier).
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The following picture shows the analysis for the Frame. To view all four analyses in the sample project,
simply select each item and then view the Risk Discovery tab in the Analysis panel.

j Properties ! Risk Discovery | FMEA | |s) DVPER

Label

New Technology

New Application

Historical Problems

Safety Issues

Mission-Critical

Regulatory

Specifications

Functions

Performance

Loading

Environmental Loads

Use Loads/Stresses

Max Temp.

Use Temp.

1

Question
Dioes the design involve new technology?

Dioes the design apply existing technology in a new
way?

Have there been historical problems with this item?
Is there a potential For safety-related issues?

Is this a mission-critical item?

Changes or concerns related to Reqgulatory
Requirerments?

Changes or concerns related to the Specifications?

Changes or concerns related to the expected Functions?

Changes or concerns related to the Performance andfor
Performance Requirements?

Changes or concerns related to the expected Loading?

Changes or concerns related to other Environmental
Loads?

Changes or concerns related to Use LoadsStresses?

Changes or concerns related to the HighTemperature
Lirnit?

Changes or concerns related to the expected Use
Temperature?

| Mark item For more detailed analysis

-
', Response —

Mo

es

es

il

Based on the results of these analyses, the team decides to perform Design FMEAs (DFMEAs) for all four

items.
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3.6 Design FMEAs

o (-A In this section, you will continue working with the “2. Chandelier - Assess Design Reliability”
"’ project in the quick start repository, using Xfmea/RCM++/RBI.

You use Xfmea/RCM++/RBI to record the DFMEAs for the Frame, Wiring, Bulb and Socket. Each
DFMEA can be done by the same or different teams. A Risk Priority Number (RPN) approach is used to
assist in prioritizing the causes that need mitigation.

For example, the following picture shows the FMEA for the Frame. (To see this analysis in the sample
project, select the Frame in the system hierarchy and then view the FMEA tab in the Analysis panel.)

2. Chandelier - Assess Design Reliability ]

A System Hierarchy j Propetties ! Risk Discovery Ll FMEA L2 DVPER
Name &0 alzl@d Description | | % RPNi RPN
=@l chandefier =l »| Holdthe Chandelier together
|—E Frame A 3 & &g Frame Cracks, Falls
|_8 Wiring Al s [H _%_[- Grouped Effects
! |_ | Break up of Chandelier {9)
—_I-a Bulb and Sacket ‘ B possible injury {100
|—J EBulb F SR ] =i Causes
LJ Socket F S ] _%_l- =) torrosion --
| I— Controls

*J corraosion.

"=} Actions
L =, Perform an accelerated best bo better understand

| _l|- Reliability Policy - Based on Initial Dccurrence
| Lial ocerence: (6 - 1in 100) [Ex1 (0.000010)]
_1|-|- =] Metal fatigue due to swinging, cydlical stresses 60 &0

ﬂ Header A Hierarchy JJ ‘Worksheet | bid Filtered |

For this item, the corrosion failure mode is the biggest concern. Its probability of occurrence, while just an
estimate at this time, is worrisome. The team has determined that additional information is needed to
better understand this failure mechanism (e.g., from literature searches on corrosion, expert opinion and/or

testing). Therefore, the requirement to perform an accelerated test is recorded as an action in the FMEA.

Note: Within Xfmea/RCM++/RBI, different views of the FMEA are available, from a traditional spreadsheet-style
view to a more efficient, flexible and advanced hierarchical view. This guide uses the hierarchical view, which
provides the most flexibility.
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You also transfer this action to a Design Verification Plan (DVP&R) and attach some related documents,
as shown next. (To see this analysis in the sample project, select the Frame in the system hierarchy and
view the DVP&R tab in the Analysis panel.)

2. Chandelier - Assess Design Reliability (3
A System Hierarchy g Froperties ! Risk Discovery Ll FMEA =) DYPER
Nanve ﬂ h x|z =] Test 0 Test Identifier  Test/Specification Requirement = Acceptance Mt
=I{@ chandslier Request # {Name) Method Source Criteria
2 EALTOT Il Accelerated test AT Degradation Internal Quantification  TED
}»B RS S | i for corrosion
}»a Wiring A 5 |
_Ll-a Bulb and Sockst
tJ Bulb S| 0 MName Type Extension Address Description
_| socket A 3 - ﬁ E Corrosion Testing Embedded File .pdf DOD docurnent on corrosion testing i
% Hj Test Request,docx Embedded File Jdocx S;r?szztnfnr arcelerated test for
l-
2
)]
o #] L x = id Close
KN i
= Header | | Worksheet I

In a similar manner, the FMEAs for the Wiring, Bulb and Socket identify other issues of concern and
additional tests that may help to improve the chandelier's reliability. (To view these analyses in the sample
project, click each item in the system hierarchy and view the FMEA tab in the Analysis panel.)

When the FMEAs are completed, you add any relevant actions to the DFR plan. For example, the
following picture shows the “Development” stage of the DFR plan updated with frame corrosion and bulb
test plans that were recommended by the FMEA team. (To see this in the sample project, select the
Chandelier in the system hierarchy and view the DFR Planner tab in the Analysis panel.)

=@ Development °.4 4262022 7leTiz0zzE
|—  SetUp FRACAS °.4 4fz6(2022 4f28(2022
.%.l’p Component Testing 'Bt,f 4282022 5282022
| Z) ALT For Carrosion °.4 462022 Sieiz0z2
| \-2) Bulb Testing ©F | ajzelzez | 7f27je02z
|—_/ Reliability Growth Monitaring e 4fzafz02z2 Flevfznzz
|—_/ Subsystem Testing ';P 5fzajz02z 6272022
|—_/ Syskem Testing ';P 6712022 FiFlznzz

We will discuss some of the specific test results later in this document (Section 3.12 on page 47).
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3.7 Failure Modes and Reliability Analysis (FMRA)

o (-A In this section, you will continue working with the “2. Chandelier - Assess Design Reliability”
"’ project in the quick start repository, using Xfmea/RCM++/RBI.

Traditionally, DFMEA analysis focuses on qualitative inputs to assess and rank the risk associated with
specific failure modes and their eventual mitigation, through an RPN approach or other ranking criteria.
We may, however, wish to also use the FMEA as a starting point for certain quantitative analyses.

ReliaSoft's powerful new Failure Modes and Reliability Analysis (FMRA) view, available only in the
Synthesis Platform, offers a representation of the system hierarchy that shows the FMEA functions,
failures and causes for each item directly within the hierarchy.

This view allows you to assign reliability characteristics at the item level or at the function, failure or
cause levels. This can be used for a variety of purposes, including the fault tree analysis that will be
discussed in Section 3.8, the simulation-based risk assessment discussed in Section 3.9 and the baseline
reliability estimation discussed in Section 3.10.

To proceed with any of these analyses, we first need to quantify the failure or event probabilities for each
cause in each FMEA.

Obviously, if prior data exist or time is available for testing, it is a simple matter to determine these
probabilities. However, for the single-light pendant chandelier, no data are available at this point other
than the qualitative inputs provided during the FMEA analysis in the form of the occurrence rating scale
that was used for RPN calculation. We can use this information as a starting point because, even though
qualitative, the scales used in any FMEA should have some quantitative equivalent (e.g., “Unlikely” is 1
in a million). The conversion of these inputs into either fixed numerical probabilities or simple lifetime
distributions (e.g., exponential) provides a quantitative starting point.

In this case, you know that the FMEA teams assigned occurrence ratings based on the probability that the
failure would occur by 1,000 hours of operation. Therefore, it is possible to use a time-dependent
exponential distribution instead of a fixed probability. This will allow the software to calculate the
probability of failure for any operating time specified for the analysis (which is 5,000 hours in this case).
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In Xfmea/RCM++/RBI, you configure the occurrence rating scale that has been defined for the current
project as shown in the following picture. (To access this window, choose Project > Management >
Configurable Settings > Occurrence.)

¥Yalue Quantitative Yalue Description Criteria 1 Criteria 2

B 0000001 1in 1 Million
2 0.000010 Lin 100,000
3 0.000100 Lin 10,000
4 0.001000 1in 1,000
5 0.002000 1in 500
& 0.010000 Lin 100
7 0.020000 lins0
5 0.100000 lin0
5 0.250000 lin¢
10 0.500000 Sin 10

1 |

Treat Quantitative Yalues As:

() Fixed probability of Failure (G
() Exponential distribution given (T3, and time (Tyis: 1000 Hour e

]

opy Existing ancel
Copy Existi = oK Cancel

Updating occurrence scale For this project

With these settings, a 1-parameter exponential model will be built for each occurrence rating using the
probability of failure entered in the Quantitative Value field (Q) and the time specified for T (1,000
hours), as follows:

Probability of Failure at Time T = Q(T)
Assuming an exponential distribution, its single parameter A can be estimated as follows:

—At

1-0(T) = R(?) = e

“In(1-0()) _,
t

It is common knowledge that the exponential distribution, with its assumption of a constant failure rate, is
flawed for anything that exhibits any type of degradation (i.e., gets worse with age). However, for the
purposes of a first cut estimate it is still useful. If the analyst feels that a more realistic model is needed,
the occurrence probability can subsequently be easily modified to use any other distribution. The model
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can also be linked to source data, as demonstrated later in this guide. In the absence of data, you could also
use the model wizard to more realistically describe the occurrence probability. For now, however, you
decide to start with the exponential assumption.

Initially, you simply want to use the FMRA to assign reliability models to each cause in order to proceed
with more complex risk analysis. To do this in the FMRA, you modify the reliability policy for each cause
so that it is calculated based on the probabilistic model that corresponds to the initial occurrence rating.
(These models are not resources that can be used elsewhere; they are simply representations of probability
using an exponential distribution.) As an example, the following picture shows the FMRA properties for
the Corrosion cause in the Frame FMEA.

2. Chandelier - Assess Design Reliability £

A System Hierarchy ﬂ FMRA j Properties
Property Name Yalue
Name
=| Cause
=@ Chandelier Short Description Carrosion
.l.l'a Frame Failure Mode Corrosion

_ll- _¥| Hold the Chandelier together

! .
=} ®| Frame Cracks, Fails Initial Occurrence -
q-__:f___.l Corrosion ) Revised Occurrence 6-1in 100 -
| =, Metal Fatigue due to Initial Detection 5 - Medium -
=/ swinging, cyclical stresses
- Revised Detection 5 - Medium -
#8 g Reliability P
=| Rehability Pol
_Jlrl-a Bulb and Socket E v Polly
Type Based on Initial Gccurrence -
=l URD Corrosion
E‘ Model Coccurrence: (6 - 1in 1000 [EX1 {1,005E-05)] )
Eﬂ Corrective Task Defaul - Cannot Be Repaired
#| History
A »|| =Cause

Note: If the FMRA tab is not already visible in the System panel, choose View > FMRA > Show FMRA. Then select
the cause in the FMRA hierarchy to see its properties in the Analysis panel.

3.8 Fault Tree Analysis

In this section, you will continue working with the “2. Chandelier - Assess Design Reliability” project in the
"-') quick start repository, using BlockSim.

You can now open the project in Blocksim, where you can quantify the chandelier’s overall risk of fire
based on different causes in the FMEAs.
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In the chandelier, fire is a possible effect across various assemblies. The table below shows the portions of
all of the FMEAs that lead to fire.

System Assembly Function Failure Effect(s)
Chandelier | Frame Hold the chandelier Frame cracks No light; Break up of chandelier;
together Possible injury
Wiring Provide electricity Aging and stress Possible injury; Fire; No light
Bending Possible injury; Fire; No light
Chafing Possible injury; Fire; No light
Delamination Possible injury; Fire; No light
Terminal point connection | Possible injury; Fire; No light
failure
Series arcing Possible injury; Fire; No light
Bulb Provide light Filament burns No light
Bulb shatters Possible injury; No light
Base fails to make contact | No light
Insufficient light Customer dissatisfaction
Socket Provide electricity to Fails to make contact No light
bulb
Short Possible injury; Fire; No light

To combine all of this information together, BlockSim provides a convenient utility that queries the
FMEAs that you performed in Xfmea/RCM++/RBI and automatically generates fault trees that show all
of the possible failure modes that could result in a particular outcome. For example, the following picture
shows the query that generates a fault tree for any failure effect that contains the word “fire.” (To access
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this utility in BlockSim, choose Insert > Build from Synthesis > Build Effect FTs from Synthesis.) This
step has already been performed in the sample project.

Build'Effect FIs from Synthesis

Synthesis Element to Build From

@ @ © RCMpsfmea g HFRACAS

Criteria to Filter Effects

|EFFect m| |Contain5 Ill' |Fire

Select Effects |

I~ Short Description Effect
Passible injury (9)
¥  Possible injury - Fire - Mo light Fire {9}
Mo light: {8)
Passible injury (9)
¥  Possible injury - Fire - Mo light Fire {9}
Mo light: {8)
Passible injury (9)
¥  Possible injury - Fire - Mo light Fire {9}
Mo light: {8)
Mo light: {8)
Mo light: - Possible injury - Fire Passible injury (9)
Fire {9}
Passible injury (9)
)

=

=

Passible injury - Fire - Mo light Fire

. Passible injury (9)
Mo Light Fire (3)

=

Passible injury (9)
Passible injury - Fire - Mo light Fire {9}
Mo light: {8)

SYNTHESIS
=l

A

<< Back Mext == [o]'4 Cancel .

The resulting fault tree (“Fire_Probability” in the sample project) shows all of the possible failure modes
that could result in fire and calculates the overall probability that fire may occur by 5,000 hours, as shown
next.

Q:1.736510%

Senr_f. An:mg Ag\ng and Slreas Bendmg Chaﬂng De\am\nat\oﬂ Terminal point

! : connection i
Q:0.049990% Q:0.049990% Q:0,499001% Q 0.049990% Q:0.049990% fajjure :
0:0,049990%
Q:0.049990% Q:0.049990 :0.499001 Q:0.049990% Q:0.049990% Q:0.049990%

Loose terminal or crimp, Deterioration of the Tight bend radii Swmg\ng and looser Failure of the bunclmg Frequent manipulation Presence of foreign Manufacturing
corrosion, or dirt in ... insulation res material conductive material

Q:0.996503%

Q:0.000500%
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It is a simple matter to do the same for the “possible injury” and “no light” effects. You then use these fault
trees as subdiagrams in a fault tree (“Any Effect” in the sample project) that shows the probability that
any of these effects will happen by 5,000 hours, as shown next.

Q:17.521810%

Q:1.736510% Q:7.487306% 0:9.271107%

Fire_Probability Injury_Probability No_Light_Probability

You also create an overlay plot ( “Effect Probabilities of Occurrence” in the sample project) that shows
how the probabilities of occurrence of the effects compare, as shown next. (Note that labels have been
added here for clarity.)

Unreliability vs. Time

0.500 Unreliability
Fire_Probability

— Unreliability Line
. - Injury_Probabili
No_Light_Probability kil B{ﬁeliabiliy tIzline
No_Light_Probability
— Unreliability Line

0.400 Injury_Probability

0.300

1-R(t)

0.200

Unreliability, F(t):

Fire_Probability

0.100

0 10000.000 20000.000 30000.000 40000.000 50000.000
Time (Hr)

Finally, you return to the fire probability fault tree and publish it as a model that can be used in other
analyses. The following picture shows the Publishing page of the fault tree's control panel, which provides
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the tools you need to create and manage published models based on a particular BlockSim diagram. (To
view this page, click the Publishing icon at the bottom of the control panel, as indicated in the picture.)

Publishing 1

Fitted Model o =
; IStatus Unpublished
-
-
’5
Analytical Model [T
; BlockSim_Fire_Probability_Anal
ytical
E‘\- Status Published
m Linked? In Use
ﬁ Synchronized?  Synchronized
ReliaSoft
& |CreatedBy Corporation
o ReliaSoft
Maxdtied By Corporation
:;'Q] Analytical

AH Analysis Settings

3.9 Using Flowchart Simulation and DOE

% In this section, you will continue working with the “2. Chandelier - Assess Design Reliability” project
in the quick start repository. Some of the steps are performed in RENO and some in DOE++.

The information about risk that you have obtained thus far can be put to further use. For example, the
probability model that you created for the “fire” effect can now be used to help you understand the
potential outcomes associated with fire and thereby assess and quantify the associated risk for the end
user.

To evaluate the potential outcomes associated with fire, you build a RENO flowchart that starts with the
probability of fire, based on the published model at 5,000 hours, and takes into account the following
event probabilities:

e The probability of the fire being noticed right away = 0.2.

o If the fire goes unnoticed, the probability of the alarm being activated = 0.95.
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e If the alarm is activated, the probability of the fire department receiving the notification = 0.9.
e The probability of the fire department arriving in time = 0.9.

e The sprinkler system may be activated if the alarm fails or if the fire department fails to respond in
time. The probability of the sprinkler system being successfully activated in either case = 0.9.

The following picture shows the flowchart (“Fire Effect Outcome” in the sample project), along with the
properties of the originating event (i.e., fire).

Thermal
Event

Fire Dept

Bl N Sprinkler
1 ) + Activated
Ak
Eaiy
imE
Sprinkler - Water
Activated Damage
& Block Properties @ tad
Properties
=I @ Block {Standard Block)
Elock Mame Thermal Event
L Biock hermal
= B Block Properties
}»Equation Elocksim_Fire_Prabability_analytical{S000) —)
odel published from
"~ Model published fi
L Storage Yariable (Mot Set) frT BlockSim fault tree
= Dﬁ Identifiers
® L comments
-
\=
E Active Block | Stwle.. || Ok || Cancel |
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Simulating this flowchart and plotting the results gives you an idea of the probabilities of various
outcomes.

Result Storage Bar Chart
0.014

Fire Effect Outcome

Il House Burned
I Injuries

I No Damage
[l Water Damage

0.011

0.008

0.005

0.003

0 —
House Burned Injuries No Damage Water Damage

[Flowchart: Fire Effect Outcome - Simulations per run: 1 - Sensitivity Analysis Disabled - Multiple Analyses Disabled

In this case, the outcome of greatest concern to you is the possibility of injury. You decide to use Design of
Experiments (DOE) analysis to determine the factors (or events) that have the greatest effect on the
probability of injury due to fire.

To do this, you first duplicate the RENO flowchart. In the new flowchart (“Fire Effect Outcome DOE” in
the sample project), you replace the following probability values with variables.

e Noticed

e Alarm Activated

e Respond in Time

e Sprinkler Activated

A variable is a Synthesis resource that stores a numerical value and allows you to assign a name to that
value. You can then use the variable name in place of the actual value in the equations that you create, and
the value of the variable can be changed during simulation.

For example, in the Block Properties windows shown next, the one on the left shows the probability of
sprinkler activation defined as a constant (0.9) in the original flowchart, while the one on the right shows
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it defined using a variable called “Sprinkler” in the new flowchart. The variable method allows you to try

different values during simulation.

& Block Properties

Properties

=l ' Block (Binary Node)
L Black Name

=l @ Block Properties
L condition is TRUE - T Path

Sprinkler Activated

Properties
=l ' Block (Binary Node)
L Black Mame
=l @ Block Properties
L condtion is TRUE - T Path

Sprinkler Activated

=l Dﬁ Identifiers

=l Dﬁ Identifiers
L Comments

L Camments

Active Block | Sprinkler Activated v Style.., oK Cancel Active Block | Sprinkler Activated |~ Style... oK Cancel

o o
X

Using Fixed Probability Value Using Variable for Probability

In the new flowchart, you also set the Injuries block (i.e., the resulting probability of injury) to store its
value in a variable. Storing the result in this way will allow it to be used in a simulation worksheet, as

explained in the following steps.

© DOE++

You then open the project in DOE++ and build a general full factorial design (“Injury from Fire” in the
sample project) that sets eight different levels to be considered for each of the factors, as shown next. (To
access this design summary in the sample project, click the Detailed Summary link on the Design tab of
the design folio.)

General Full Factorial

Response Properties

Name Units
Injury Probability
Factor Properties

Abbreviation Name Units Type Mumber  Level 1 Level2 Level3 Level4 Level5 Level6 Level7 LE\.’EI 8
of Levels (Low) (High)

MNT Noticed Quantitative 8 0.05 0.1 0.2 0.3 0.4 0.5 0.7 0.8

AL Alarm Activated Quantitative 8 0.1 0.2 0.3 0.5 0.7 0.9 0.95 0.9

SP Sprinkler sctivated Quantitative 8 0.2 0.3 05 0.7 0.8 049 095 099

FD FD Respond in Time Quantitative =] 0.1 0.3 0.5 0.7 0.8 0.9 0.95 0.99

Additional Settings
# of Unique Runs 4096

# of Blocks 1
Center Points / Block u]
# of Replicates 1
Block on Replicates Mo
Total # of Runs 4096

You then transfer the factor settings to a new simulation worksheet. The simulation worksheet is a flexible
new tool that's available in DOE++, BlockSim and RENO. In this case, you will access the same
worksheet in both DOE++ and RENO in order to a) design an experiment in DOE++, b) use a RENO
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flowchart to obtain the “response” data via simulation, and then c) return to DOE++ and analyze the
simulated response data.

The following picture shows how the worksheet looks after you have transferred the factor settings from
the experiment design, but before the response data has been populated by RENO. (You won't be able to
see this stage of the analysis in the sample project. The simulation worksheet in the sample project is
complete, and looks like the step shown on page 35.)

kL Simulation Worksheetl

Simulation Worksheet 1|
MNoticed | Alarm activated [Sprinkler Activated|FD Respond in Time | Injury Probability | =] _
0.4 03 03 0s | |fe— =
0.1 0.7 0.2 0.8 "?J Commit and Lock
01 0.2 0.8 01 & —_—
0.5 0.5 0.2 0.3
0.05 0.9 0.5 01 |_—J
01 0.2 0.2 0.3
0.3 0.7 0.9 0.5
0.7 0.00 0.3 0.95
0.2 0.3 0.2 0.2
0.7 01 0.99 0.5
0.4 0.95 0.95 0.3
0.7 0.95 0.5 0.3
0.2 0.7 0.3 0.7
0.5 0.5 0.7 0.1
0.3 0.95 0.09 0.1
0.5 01 0.2 0.95
01 0.05 0.7 01
0.2 01 0.2 0.99
0.3 0.95 0.7 =
0.7 01 0.3 |Nute: Complete data set is not shown. |
r

You commit the changes and lock the worksheet in DOE++ so you'll be able to work with it in RENO.

@ RENO

You then return to RENO and open the same simulation worksheet. When you click the Simulate icon in
the control panel, the Select Diagram window appears. In this window, you first select the flowchart
diagram that will be used to generate the response data. Then you specify which variables from the
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flowchart will be associated with the factors (inputs) and response (output) in the DOE analysis. The
following pictures show these settings.

& Select Diagram

f'ew & Waorksheet Simulation
() Hierarchical !
(2) Alphabetical Flowchart to be Simulated
Fire Effect Outcome DOE
Available Diagrams
=1 [134] RENO Flawicharts Source of Yariable Inputs
' Fire Effect Outcome Specify the worksheet columns that will supply input walues for variables in the diagram that will be
% Fire Effect Cutcome DOE simulated.
Input Column Yariable
Moticed Moticed
Alarm Activated Alarmact
6 Sprinkler Activated | Sprinkler
@ FD Respond in Time |FDResp0nd ]

Injury Probability

»

Simulation Dutput

Specify the workshest columns that will display the values from the variables that store results in the
simulated diagram.

Moticed
#larm Activated
Sprinkler Activated

Dutput Column Yariable ﬂ

O ©

FD Respond in Time

Injury Probability |Injury

»

[P Edit Simulation Settings

| | Simulate  Clase J

When you run the simulation (using 1,000 simulations with a seed of 1 for repeatability), the factor
settings entered by DOE++ into the simulation worksheet are used by each specified variable in the
RENO simulation. And likewise, the values generated by the RENO flowchart and stored in the Injury
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variable are used to populate the DOE response column in the simulation worksheet. For example,
consider the values in the first row of the simulation worksheet, as shown next.

L3 Simulation Worksheetl |
A4100 I Simulation Worksheet 1
moticed | alarm sctivated | Sprinkler Activated [FD Respond in Time [ Injury Probmy__;l _ SIMULATIONMORKS HEE |
1 C o4 0.3 0.3 0.5 0.005105336571 ) | p—
2 0.1 0.7 0.3 0.8 0.00326200356 S| e el
3 0.1 0.2 0.8 0.1 0002500574141 i
4 0.5 0.5 0.2 0.5 0.00347301964 o
5 0.0s 0.9 0.5 0.1 0.0008248421645 TG Colimis
6 0.1 0.2 0.2 0.5 001000229656 il e
7 0.3 07 0.9 0.5 0.0003646670622 o Aoared | Blarmt
g8 07 0.93 0.3 0.95 2.646670622E-005 T
a 0.8 0.3 0.2 0.8 0.001944890998 R hivatad Sprinklar
10 07 0.1 0.93 0.5 4.688576514E-005 FD Respond in
11 0.4 0.95 0.95 0.3 2.60476473E-005 Time FDRespond
12 0.7 0.95 0.5 0.3 0.0001302282365 Output Columns
13 0.2 0.7 0.8 07 0.0008335247136 Inury I
14 0.5 0.5 0.7 0.1 0.001302382365 Probabilicy Iy
15 0.3 0.95 0.93 0.1 £.07778437E-006
16 0.5 0.1 0.8 0.95 0.001562858338 Last Impotted From
17 0.1 0.95 07 0.1 0.0002244288257 e
18 0.2 0.1 0.2 0.93 001000229656
19 0.3 0.95 0.7 0.95 0,0001523335311 i S (N800 6
20 0.7 0.1 0.3 0.95 0.00328200356 Last Exported To
21 0.2 0.9 07 0.9 0.0004167623568 ] 1y fromFi
22 0.8 0.95 0.99 0.3 1.73650982E-006 LnRLvLromibie
23 0.5 0.3 0.2 0.7 0.004662227496 10/23/2013 11:13:46 AM
24 0.2 0.1 0.95 0.1 0.0006251435352 |+ | 1=
| ¥ [:34 Fire Effect Outcome DOE

In the first simulation, the value in the Noticed column, 0.4, is used by the Noticed variable to define the
probability that the fire is noticed. Similarly, the AlarmAct variable is set to 0.3, the Sprinkler variable is
set to 0.3 and the FDRespond variable is set to 0.5. Given these values in the flowchart simulation, the
probability of injury is found to be approximately 0.005.

After the response data has been generated, you again commit and lock the simulation worksheet so you'll
be able to work with it in DOE++.
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© DOE++

You return to DOE++ and refresh the simulation worksheet to display the response values that were
generated from the flowchart simulation (i.e., the Injury probability for each combination of factors).

You then transfer the response data from the simulation worksheet to the design folio. When you analyze
the data set (“Injury from Fire” in the sample project), you see that three of the four factors are significant,
along with several interaction effects, as shown next.

Analysis Summary

Significant Terms
Term Coefficient
MT:Moticed -0.0012
AL:alarm Activated  -0,0018
B am
MT « AL 0.0012
MT « 5P 0.0012
AL« SP 0.0015
Zmore...

Detaled Summary...

You use a Pareto chart to view the effects of the significant terms, as shown next.

Pareto Chart - Regression

Pareto Chart - Regression
g{r]ju Probability

g;jﬁ Probability

Injury Probabili

Y,J;& ity

M Significant

[ Non-significant
— Critical Value

AL:Alarm Activated

SP:Sprinkler Activated

AL » SP

NT:Noticed

Term

NT ¢ AL

NT o SP

NT ¢ AL * SP

1.4000E+17 2.8000E+17 4.2000E+17 5.6000E+17 7.0000E+17
Standardized Effect (T-Value)

Risk Level = 0.1; Critical Value = 1.6452

From this plot, you determine that alarm activation and sprinkler system activation are the two main
factors that influence injury.
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3.10 Estimate the Baseline System Reliability

o (-A In this section, you will continue working with the “2. Chandelier - Assess Design Reliability”
"’ project in the quick start repository, using Xfmea/RCM++/RBI.

You return to Xfmea/RCM++/RBI to work with the Failure Modes and Reliability Analysis (FMRA) that
you created earlier (see Section 3.7 on page 23). This time, you will use the reliability models that were
obtained from the FMEA occurrence ratings to generate a preliminary estimate of the system's baseline
reliability.

Assuming that any one of the FMEA causes could cause the component to fail (i.e., the causes are
reliability-wise in series), the FMRA combines the cause reliabilities to get the reliability of each
component. It then combines the component and assembly reliabilities until reaching the system level.

The following picture shows the reliabilities calculated from the “first draft” FMRA that is based solely on
the information from the FMEAs. For a system operating time of 5,000 hours, the computed reliability for
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the entire chandelier is about 84.95%. (This stage of the analysis is not visible in the sample project. The
FMRA shown in the sample project reflects changes made during FMRA vetting, as explained next.)

‘ Syskem Hierarchy | EaFMRA |

MName ﬁ % Reliability Policy || (gﬁlaila:tiilli:?;)
Chandelier Inherit 0,549493
3B Frame Inherit 0.950843
_ll-ﬂ Hold the Chandelier together Inherit 0.950943
_ll»ﬂ Frame Cracks, Fails Inherit 0.950043
|—’- Carrosion Carrasion 0.950990

| L_gj Deterioration of the insulation

| l—_;] Swinging and looser wires
_%_I-ﬂ Delamination

| L'gj Failure of the bonding material
_%_I—ﬂ Terminal point connection Failure

| l—_gj Frequent manipulation

_ll-ﬂ Series Arcing

;I-E Bulb and Socket

L_;J Metal fatigue due ko swinging, cyclical stresses

L_éj Laose terminal or crimp, corrosion, or dirkin ...

Metal fatigue due ko swinging, cyclical stresses

_—J- Wiring Inherit
_ll-ﬂ Provide Electricity Inherit
_%_I—ﬂ Aging and Stress Inherit

Deterioration of the insulation

_%_I—ﬂ Bending Inherit
| L_éj Tight bend radi Tight bend radi
_%_l-ﬂ Chafing Inherit

Swinging and looser wires

Inherit

Failure of the bonding material

Inherit

Frequent manipulation

Inherit

Laose terminal or crimp, corrosion, or dirkin ...
Inherit

24 | Bub Inheric 0.922861
_ll-ﬂ Provide light Inherit 0.922861
_%_I—ﬂ Filament burns Inherit 0.950990
| L_éj Filament burns Filament burns 0.950990
_%_l-ﬂ Bulb shatters Inherit
|—_;J Overheat COverheat

I L_éj Spike in voltage
_%_I—ﬂ Base fails to make contact
| L_éj Cap Fails to screw all the way
_ll-ﬂ Insufficient light
L';J Bulb wattage too low

Spike in valtage

Inherit

Cap Fails to screw all the way
Inherit

Bulb wattage too low

=t | socket Inherit 0.975283
_ll-ﬂ Provide electricity to bulb Inherit 0.975283
_%_I—ﬂ Fails to make contact Inherit

| |—_§j Dirty contacks
| L'gj Solder connection Failure

= #| sShart

|—_§j Presence of foreign conductive material

L';J ManuFacturing

Dirty contacks

Solder connection Failure

Inherit

Presence of fareign conductive material

ManuFacturing
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3.10 Estimate the Baseline System Reliability

It is extremely important to note at this point that this first draft FMRA system reliability value may be
nowhere close to the true reliability value. You now need to go back through the first draft FMRA and
review each entry and the overall result. This is called FMRA vetting.

A

FMRA Vetting: In general, the FMRA vetting process involves these two steps:

e Cleaning Up
During this step, you review the failure causes that are being considered in the analysis and
perform any cleanup that may be required to make sure the FMRA considers all the causes
that impact the system'’s reliability, but does not consider causes that don't.

e Reviewing and Validating Inputs
During this step, you examine the calculated reliability estimates for each record to see if
they fit your expectations. If not, you determine which inputs to the FMRA and DFMEAs
might need to be revised with better information.

The ReliaWiki resource portal provides more information about the FMRA vetting process at:
http://www.ReliaWiki.org/index.php/Using FMRA_to_Estimate Baseline_Reliability.

When you begin to vet the first draft FMRA, the first thing you notice is that the “Bulb wattage too low”
failure cause (which occurs if the user installs the wrong type of bulb) was something that needed to be
considered during the FMEA, but it should not affect the chandelier’s calculated reliability.

To prevent the software from considering this cause, you set the cause’s reliability policy to Define at this
level and remove the URD that was previously assigned to the cause. The software will assign a model
with 100% reliability (“Default - Cannot Fail”), as shown next. (This is how it appears in the sample
project.).

=l Reliability Polcy

Type Define at this level -
=l URD Default (Mot Set)
h Model Default - Cannot Fail -

This means that the cause record will essentially be ignored in the reliability calculations because the
cause reliability will always be 100%.

When you recalculate the FMRA after making this change, you find that the system reliability changed to
approximately 85.80% (as shown in the sample project).

You continue reviewing the rest of the analysis and make any updates that may be appropriate. Once
vetted, the baseline reliability value is your initial design reliability. You will compare this with the target
reliability, keeping in mind that this first baseline estimate is usually optimistic because you have not
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accounted for other reliability contributors, including interactions. Furthermore, the product needs to go
through manufacturing, and the manufacturing process will not increase the reliability. Thus, you want
your initial baseline reliability value to exceed your reliability target value.

From a knowledge base viewpoint, it is also important to note that the FMEA and related FMRA should
be updated continuously as new information becomes available, including the addition of new failure
modes uncovered during testing as well as the revision of the underlying reliability models based on data
obtained from testing. Upon the product’s release, this process should continue with field information.

3.11 Identify Reliability Gaps

In this section, you will switch to the “3. Chandelier - Identify Reliability Gaps” project in the quick start
repository, and perform the analysis using BlockSim.

Your next task is to perform a more advanced system analysis in order to better understand the system
reliability and evaluate where to focus your efforts for improving the reliability.

You open the project in BlockSim and use the Build RBDs and FTs from Synthesis utility to create a set
of reliability block diagrams (RBDs) based on the latest information from the FMEAs and FMRA. The
following picture shows the settings that were used to create these diagrams.

Options

Synthesis Element to Build From
g ﬁJ (0) RCMA+{%fmea g Qﬂ () Lambda Predict
Diagram Type
() Fault Tree  (CVRED () Hybrid |Analytical w | |w| Create Folders
Subdiagram Grouping {(RBD)
| Create system-level diagrams

Create subdiagrams For functions

Create subdiagrams For Failures

Overridden Items

Import items even though overridden by higher level definition

MNexk = Cancel

) X0
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You open the main diagram, called “Chandelier,” which contains subdiagrams that represent the three
assemblies. You then double-click each subdiagram to see its components. The following image shows all
of the diagrams in relation to each other.

Frame

L]

Wiring

Bulb and
Socket

»»

Corrosion  Metal fatigue
due to
swinging,
cyclical
stresses

Bulb Socket

"o o

P I I I I

Tight bend  Swinging and Failure of the Frequent  Loose terminal Deterioration
radii looser wires bonding manipulation or crimp, of the
material corrosion, or insulation

dirtin ...

Dirty contacts Presence of Solder  Manufacturing
foreign connection
conductive failure
material

EREEE.

Overheat Filament burns Cap fails to  Bulb wattage Spike in
screw all the too low voltage
way
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You return to the main diagram and choose Analysis > Analytical QCP. You see that BlockSim's QCP
returns the same reliability result for R(t=5,000) as the FMRA view in Xfmea/RCM++/RBI.

R
& 0CP EalEs)

Calculate Input

l Reliakility l'] Mission End Time (Hr)

Probability I Rioh,,of Eaile, J

| Cond. Reliability |

| Cond. Prob. of Failure J

Reli if

Life | Bx% L @ |

| Mean Life J
Rate | | Failure Rate J [ { -~

Calculate

Now you want to investigate how to improve this number to get to the target reliability.

One approach is to start at the system level and look at the reliability importance of each assembly.
Reliability importance is a measure of how much effect each assembly or component has on the overall
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reliability of the system. The following picture shows the Static Reliability Importance plot for the

“Chandelier” diagram (which is accessible from the Analytical Plot sheet in the diagram window).

Static Reliability Importance

0.944

0.755

0.566

0.378

Reliability Importance Value

0.189

Reliability
=100%

50%

0%
Chandelier
3 Items

Bulb and Socket

Frame

Time = 5000 (Hr)

Wiring

You can view the same plot for the other diagrams, all the way down to the underlying causes.
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Alternatively, BlockSim's FRED reports offer a less time-consuming and more readily understood
approach. A FRED report can automatically trace the entire RBD structure and highlight the root causes
from a reliability perspective, as shown next (“FRED Reportl” in the sample project).

Chanfelier

— 3

R=0.950943

Fraime il Bulb andl Socket
b A
/—L
R=0.950990
Imp=0.999950 R=0.975283
Corrosion Metal fatigue Socket
due to
swinging, - ¥ +
cyclical stresses
R=0.990040 R=0.995010 R=0.950990 R=0.995010
Imp=0.941523 Imp=0.936820 Imp=0.980184 Imp=0.936820
Cap fails to Overheat Filament burns Bulb wattage Spike in voltage
screw all the too low

way

Here, all items with low reliability have been expanded to show the items that contribute to the problem.

e The Bulb and Socket assembly is clearly the primary unreliability driver. Within that assembly:
o The Bulb is the major contributor.

e The Bulb’s primary root cause of failure is the tendency of the filament to burn.

e The secondary unreliability driver is the Frame assembly.
o The Frame’s primary root cause of failure is corrosion.

Having identified these root causes, the next course of action may be to question the FMEA team as to the
reasons behind each cause. This more advanced look at the FMEA, through a system reliability focus,
highlights items that need further attention and investigation, and items that need to be addressed in order
to meet the target reliability.

You can also use the BlockSim diagrams to determine the target reliability for these assemblies and failure
causes of interest. To do this, you add an allocation analysis ( “A/location Analysis” in the sample project),
based on the Chandelier diagram. On the control panel, you change the inputs to reflect the goal of 95%
reliability at 5,000 hours and choose the cost optimized allocation type. You change the color limits to
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85%-100% to make the analysis easier to read, and you clear the check box for the Wiring assembly,
because the causes of interest (as determined via the reliability importance plot and/or the FRED report)
do not relate to that assembly. The resulting allocation analysis is shown next.

= Allocation Analysis

M aximum

Calculations

u| Ieotence: | Rekakitty feticaticy Licabil Rehatity  Porali ks
Ird Frame 0,902310  0.950943 1 Easy (1) 0.982068 1.333824
Wiring 0,864507  0.992525 1 Easy (1)
ggfkae?d 0.943535 0,909105 1 Easy (1) 0.974632 1.532175
Chandelier

Current Reliability 0.853045

Syskem Reliability 0,950000

g_'ﬂ Allocation Type 0 L

m ( |Cost Optimized ) ,l,|

[ | Refresh J
Inputs

Target Reliabilicy (bos) |

Time S0 N |

Units Hour {Hr) A
Outputs

| Color Limits

h&s% - 100%)

| [+ Chandelier

To view more specific results on the Frame assembly, you click its name in the table. This adds an
additional allocation analysis to the folio with the target reliability already in place. The current reliability
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for the “Metal fatigue” cause is already almost 100%, so you clear the check box for that cause. The
calculated allocation analysis for the Frame assembly is shown next.

= Allocation Analysis

Calculations

Maximum

Achievable = Feasibility RTarget Equivalent

v Block Reliability Current

b M 0 A OCATIO
Name Importance Reliability Reliability eliability  Parallel Units
[ corosion [I0:8885000| 0.950950 1 Easy (1) | 0.982116 1.334268 £ | Allocation Type (T
3‘13'15| fatigue T |Cost Optimized m|
ue to
swinging, 0,950990 0,999950 1 Easy (1} - - ¢
@ cyclical - @ | Refresh |
stresses
Inputs
Target Reliability 0,932068
Tirne 5000
Units Hour {Hr)
DOutputs
Current Reliability 0,950943
Syskem Reliability 0,932066
Color Limits
[a5% - 100% |exa)
|E Frame |
Chandelier Frame I

The Corrosion cause was one of the causes of interest identified in the FRED report. In the Target
Reliability column for this cause, you see that the reliability value that should be achieved for the
Corrosion cause, in order for the Frame assembly to reach its target reliability, is about 98.21%.
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You then return to the Chandelier tab and click the name of the Bulb and Socket assembly to create an
allocation analysis for it, as shown next.

= Allocation Analysis

Calculations 4

B 1L ATR Maximum -
v Block  Reliability l:l.!rre_r_lt Achievable | Feasibility T_arg_e_l: Equlvalen_l:
Mame Importance Reliability i Reliability Parallel Units
Reliability

¥  Bub 0.975283 0.932145 1 Easy (1) 0.983673 1.529488 £ | Allocation Type (T

¥  Socket  0.932145 0.975283 1 Easy (1) 0,990509 1.267359 . | |Cast Optimized .
|§| Refresh
Inputs
Target Reliability |0.974632
Time
| Units
Iterations 50
Outputs
| Current Reliability |0.909105
Syskem Reliability |0.974632

Color Limits

85% - 100%

| [2+4] Bulb and Socket
Chandelier | Frame  Bulb and Socket .

You will recall that the Bulb was the main contributor to the unreliability of this assembly. Because the
Bulb is a component that you purchase, you do not need to examine it at the cause level; a single target
reliability for the component is sufficient. The value shown in the Target Reliability column for the Bulb is
about 98.37%. The Socket was not a significant contributor to unreliability and does not require further
analysis.

3.12 Improve the Reliability

@ " Q C:;> In this section, you will work with the “4. Chandelier - Improve Reliability” project
- in the quick start repository. Some of the steps are performed in Weibull++/ALTA
and some in Xfmea/RCM++/RBI.

With the primary root causes identified, the team can now focus on increasing the reliabilities of these
specific items in order to assure that the target will be met. To do this, you expand the analysis to include
models created from data.

Up to this point, the models and modeling assumptions used have been fairly simplistic and based on the
qualitative values entered in the DFMEA. As the design effort progresses, these reliability estimates can
be replaced with more robust estimates. These could be based on actual test data, reliability growth data,
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simulations, etc. By performing these analyses in other Synthesis applications, you can create newer
quantitative models to replace the first cut approximation.

For example, as you saw in the allocation analysis, the current reliability associated with the Corrosion
cause is about 95.10%. This indicates that corrosion occurs in about 5 out of every 100 items. You
determined in the allocation analysis that this needs to be improved to 98.21%, or approximately 18/1,000.
To address this, you proceed with the accelerated corrosion test requested by the FMEA team.

@ wesuLL++ © ALTA

You perform an analysis of humidity readings from throughout the country in Weibull++ ( “Environmental
Data” in the sample project), based on the data in the Excel file attached to the DFR planner. Then you
use the QCP to obtain the mean humidity value, as shown next.

= i s
a1 | Main .
Hurmidity Subset jl STANDARD, FOLIO
D1
1 o5 Arizona £7 | Distribution [T
2 29 MNew Mexico ,( |
& 32 MNevada
4 35 Colorado |
5 41
5] 43
g 43 MElgu l++ gtandard Folio: Enviranmental D atahDatal
g 45
9 48
o 2 | IMTTF 65.434100 H
it 49 " r
12 49
13 50
14 S0 (Mean Life Hr Mo Bounds Captions On
12 gé gcpi WIG& CALCULATION PAD Units > Bounds > Options e
17 52 Calculate Input
18 =) i
19 5z Reliakility
Prob, of Fail
20 52 Probahity rob, of Failure
21 53 Cond. Reliability
22 53 -
o3 =3 Cond. Prob. of Faiure
Datal Reliable Life
Life BX% Life
Mean Life |
Rate Failure Rate
Calculate
Close
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Next, you perform the accelerated life testing for frame corrosion that was requested (see Section 3.6 on
page 21). Using the mean humidity value you just obtained as the use stress for humidity, you then
analyze the data in an ALTA standard folio ( “Corrosion ALT” in the sample project).

2 Corrosion ALT

Murnber State State Huridity Chemical Subset STANDARD,F

in State ‘ Fars ‘ End Time RH % Time Ti) il
1 1 F sa7 g0 2 | |widlodel LT
2 1 F 698 =] 2 1 : :
El 10 S 720 a0 2
4 1 F 353 a0 3 Select Stress Columns. ..
5 1 F 450 f=n] e Stress Transformation. ..
? é ; ?;g gg g Analysis Settings
8 1 F 187 95 2 HEE
9 1 F 277 93 2 Fr1
10 1 F 349 95 2 F=15/5=15
11 1 F 419 95 2 Set Use Stress...
12 1 F 498 93 2 ~
13 1 F 611 oS > Analysis Summary
L4 ! F 147 2 3 i ;:t':me':ers 3.095272
15 1 F 158 95 3 Alpha
16 1 F 214 95 3 —— Alpha(D) (Hr) 12.236179
17 1 F 31z =] 3 | plphal) -0,082531
13 Alphalz) 3.298163
19 Scale Parameter {at Use Stress)
20 Eta (Hr) 25193, 269495
21 Other
22 LK Yalue -101 :84324?
o3 ALTA Corrosion
24
25 1) Main
26
o7 ‘H Analysis
28 -

|| Humidity @f_u:n
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Using the QCP to calculate the reliability at 5,000 hours, you get a result of 99.33%.
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You publish the model, as shown next, to make it available for subsequent use in the FMRA.

230 | ALTA Model Publishing
Murnber State State Huridity Chemical Subset | 4] [ STANDARDEGLIG,
in State [ S End Time EH [« * Timesv D1 _ o
1 1 F 557 50 2 -
z 1 F 698 a0 2 [@%] [aLTA_Corrosion
& 10 S 720 20 2 lg |Status Published
gl 1 k 338 80 3 Linked? InUse
) L F 450 e & m Synchronized? | Synchronized
& 1 F 615 &0 3 c [ -
7 5 s 720 a0 3 Crestedpy  olasolt
B 1 F 187 EER — | & [Srparn
9 1 F 277 93
10 1 F 349 95
1 1 F 419 oS Model Name Model Category
1z 1 F 408 o5 ALTA_Corrosion
13 1 F 611 95
15 1 F 158 a5 Source Corrosion ALT/Humidity
16 1 F 214 o5 Application ALTA
17 1 F 312 93 Type Standard Folio
12 Skatus Synchronized
:
o1 GLL-weibull =
22 Beta 3.095272
e Alphaln) 12236179
24 Unit: Hour
25 ﬂ Use Stress 65.43; 1
2 7
27 u
T Mumber
28 :
|- Version
Hurmidity . E applies t
m Keywords
o« Used by 1 item m @__ [a]'4 Cancel

Another issue is bulb reliability. In this case, your team decides to consider three bulb models (61A, 69C
and A14) for use in the chandelier.
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For model Al4, you perform an accelerated life test and analyze the data in an ALTA standard folio

(“Bulb Model A14” in the sample project).

‘2] Bulb Model 14

State Titne to Yoltage Subset
Fors For S H W o1
1 F 1480 140
2 F 1624 140 : :
El F 1748 140
4 F 2530 140 Select Stress Columnns. ..
5 F 2600 140
? E gg:g 133 P Analysis Settings
8 s 3000 140 = MLE
g 5 3000 140 s FM
10 S 3000 140 i F=13/5=3
11 F 1600 143 ~ et Use Stress...
12 F 1660 143 Y
13 F 17090 143 - Analysis Summary
14 F 2320 143 <ij Parameters
—— Beta 44155862
15 F 2640 143 ¥ (Hr) 3.518474E-27
15 F 2812 143 —n 10.713257
17 Eﬂ Scale Parameter (at Use Stress)
18 Eta (Hr) 15095,343515
19 Other
20 LK Value -104.763069
21 ALTA Bulb Model A14
=0 T e T
23 1) Main
24
25 ,@] Analysis
26
Datal | I@II&II:I

52
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For the other two bulbs (61A and 69C), you perform traditional life tests and analyze the data with
Weibull++ standard folios (“Bulb Model 614" and “Bulb Model 69C " in the sample project).

& Bulb Model 614

Main
Kurmnber State State Subsat B
in State ForS End Time (Hr) D1
1 1 3 1812 g_"l] | Distribution =
2 F 1851 |
g 1 F 2196
4 1 F 2733 Analysis Settings
5 1 F 3921
RRX SRM
5] 1 F 4023
7 1 F 4143 i D
= —alS—
a8 1 F 4188 F=gf3=12
ri
= 2 12 = 4500 = Analysis Summary
= Bulb'Model 69c 3| %7 parameters
” - Beta 2.548513
M
A0 20 2 A eaem 5696,777191
State Titne to Subset =l sSTANDARD FOLIO B Other
ForS For S (H) D1 1 Rho 0.927413
1 F 4100 | H LK Walue -78.542747
2 F 4268 | b
E F 4536 &
4 F 4344
s F 5443 1| Main
5] F 5540
7 F S912 I8 énalysis
g F 5012 F=8/5=12 .
2 N Ll Analysis Summary =3l et
10 s 6000 -
| Parameters
i s L Beta £.590177
12 s 5000 520 Eta(Hn 563,21 6644
13 S 6000 ? Other
14 S 5000 =1 Rha 0,969224
15 5 5000 E LK Yalue -75.547962
16 S 6000 e
i s £000 @
18 S 6000 —
19 5 5000 | Main
20 S 6000
21 B analysis
22 -
Datsl | I@.&Q

You then create an overlay plot (“Bulb Testing” in the sample project) that shows how the reliabilities of
the bulbs compare. You will recall that the results of the allocation analysis, shown on page 47, gave a
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target reliability for the Bulb of 98.37% at 5,000 hours. This target reliability is marked on the overlay
plot, as shown next. (Note that labels have been added here for clarity.)

Reliability vs. Time
1.000 —e Reliabil
ALTA: Bulb Model A14\Datal
Inverse Power Law
Target Reliability and Time lvggmuu
F=13 | 5=3
o Data Points
0.800 — Reliability Line
Weibull++: Bulb Model 61A\Datal
2P-Weibull
RRX SRM FM MED
F=8/S=12
- e Data Points
E, — Reliability Line
X 0.600 Weibull++: Bulb Model 69C\Datal
I 2P-Weibull
= RRX SRM FM MED
Z =8/5=12
~ e Data Points
z Bulb 514 — Reliability Line
8 -e— Target Reliability
8 0.400
&
0.200
0 0 6000.000 12000.000 18000.000 24000.000 30000.000
Time (Hr)
[ALTA: Bulb Model A14\Datal: Beta=4.418862; K=3.518474E-27; n=10.713257
(Weibull++: Bulb Model 61A\Datal: Beta=2.548513, Eta=5696.777191, Rho=0.927413
[Weibull++: Bulb Model 69C\Datal: Beta=6.590177, Eta=6563.216644, Rho=0.969224

You can see that only bulb A14 meets the target requirement, so you recommend that A14 be used in the
design.
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You publish the model for the selected bulb, A14, as shown next.

2 |l
435 | ALTA Model Publishing 1
State ‘ Time to voltage Subset 5 [ .sTanNDARDEOLIC
- = 0'2 5 = Drl 4SaéHr) 1\20 v D1 Publishing =
2 F 1624 140 x | Status Unpublished
El F 1748 140
4 F 2580 140 T
5 F 2600 140 [
i] F 2820 ;
7 F 2980
g 5 3000 Model Name Model Category
9 S 2000 ALTA_Bulb Model A14 Reliability =
10 S 3000
1z F 1660 Source Bulb Model Al4/Datal
i8) F 1790 application ALTA
14 F 2320 Type Standard Folio
15 F 2640 Skatus Synchronized
-
18 IPL-weibull
19 Beta 44155862
a0 K 3.518474E-27
21 n 10.713257
22 Unit: Haour
23 ﬂ Use Stress 120
21 o
25 % Mumber
26 .
7 E ‘ersion
= e Applies ko e & || ==
m Keywords
s ] [0]4 Caniel
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© XFvMEA @ RCM++ O RBI

You then return to Xfmea/RCM++/RBI and use the models that you have just published to describe the
probability of the Corrosion cause and the reliability of the Bulb. First, you change the cause’s reliability
policy type to Define at this level and select the corrosion model in the Model field.

j Properties

Property Name Yalue
=| Cause
Short Description Corrosion
Failure Mode Carrosion
Initial Occurrence 6-1in 100 -
Revised Occurrence 6-1in 100 -
Initial Detection 5 - Medium -
Revised Detection 5 - Medium -

=l Reliability Polcy

Type Define at this level -

=l URD Corrosion_LIRD
ta Model (aLTa_corrasion [GLY (3.095, 12,236, -0.083, 3.298]] )
Eﬂ Corrective Task Defaul - Cannot Be Repaired
#| History
=|Cause
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You do the same for the Bulb, replacing the reliability estimate that was calculated by rolling up the

probabilities for the failure causes.

j Properties
Property Name
=l Item
Image E]
Item Mame
Reference Number
Part Mumber

Ikem Descripkion
Remarks

Supplier
Environmental Conditions

=| Dperation
Operating Time
Current Age
Duty Cycle
Maintenance Group

=l Reliability / Availabiity
Target Reliability
Current Reliability
Target Availability
Current Availability

=l Reliability Polcy
Tvpe

=l URD

E‘ Model

Eﬂ Corrective Task
#| History

J Item

Yalue

Bulb

al4

Specialized custom bulb designed to last
5,000 hours ar more,

Bulbs R Us
Residential use

S (7
0{Hr

0.953673

{1 392457

0,99

Nioé Calruated

Defing at this level

Bulb_URD
ALTA_Bulb Model 814 [TPw
(4,419, 3,518E-27, 10,713)]

Defaul - Cannot Be Repaired

When you recalculate the FMRA, you see that the reliability value associated with the Corrosion cause at
5,000 hours is now about 99.33%, which is more than good enough to meet the goal of 98.21% that was
determined in the allocation analysis. Similarly, the Bulb’s reliability at 5,000 hours is now 99.25%, which

exceeds the goal of 98.37%.

The overall reliability of the chandelier with these changes is now 0.954222 (approximately 95.42%)

which meets the target reliability.
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3.13 Consider a Design Change

o LFdmd

Lambda Predict and some in Xfmea/RCM++/RBI.

In this section, you will switch to the “4a. Chandelier - Design Change” project in
the quick start repository. Some of the steps are performed in ALTA, some in

At this point, your company considers the possibility of developing a new chandelier model that uses a
dimmable LED light source, in order to keep up with the latest technology on the market. This model
would use the existing design, except the incandescent bulb would be replaced with a commercial off-the-

shelf LED bulb, and an LED controller would be added.

An accelerated test has provided some degradation data for the LED bulb that you can analyze in ALTA.
You decide to use the Telcordia reliability prediction standard in Lambda Predict to calculate a predicted
failure rate for the controller.

< ALTA

First, you duplicate your project so that you can make changes to the system without losing your original
work. In the new project, you perform the accelerated degradation analysis ( “Accelerated Degradation -
LED Lamp” in the sample project) in ALTA, as shown next, and publish the model.

E Accelerated Degradation - LED Lamp

Al Main 1
lispeetion Measurement VliEge Unit ID A RGNS |
Time (Hr) Y ml -
1 100 379 128 Larp 01 £ | Degradation Model 0 =
2 150 aog 128 Lamp 01 / [ Pawer ,h{
3 200 857 128 Lamp 01
4 250 o6 178 Lamp 01 gl:l:l Critical Degradation 300
5 100 969 128 Larmp 02 Suspend After (Hr)
B 150 o138 128 Lamp 02 &k
7 200 877 128 Lamp 02 m ALTA Model (T
=] 230 800 128 Lamp 02 S [ |
2 100 1010 126 Lamp 03 . | il —
10 150 903 126 Larrp 03 /7y | Select Stress Columns...
aat 200 847 128 Lamp 03 —
12 250 795 128 Lamp 03 MLE
13 100 857 128 Lamp 04 =
14 150 743 128 Lamp 04
15 200 [i=] 128 Lamp 04 Set Use Stress...
15 230 627 128 Larrp 04 Use extrapolated intervals
17 100 893 128 Lamp 05
18 150 775 128 Lamp 05 Degradation Results
E 200 e 128 Larmp 03 Click ko view results
20 230 683 128 Lamp 03
21 100 816 128 Lamp 06 ALTA Results
22 150 785 128 Lamp 06
o3 200 745 128 Larmp 06 Beka=0.804370; K=1,054435E-41 |z
24 250 714 . L .
25 100 049 Note: Complete data set is not shown. | |
Data Platl B8 @) =
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3.13 Consider a Design Change

@ APREDICT

In Lambda Predict, you perform the reliability prediction ( “Dimmer Controller” in the sample project), as

shown next.

A immer Controller

1 of 40

System Hierarchy

Name

Category

1| Quantity  Failure Rate(t=INF) —

=IETL Dimmer Controller

Telcordia SR-332 Issue 3

1

93,7130 FITs

_l_l-' TRIAC Dimmer Dection Black
bH 7o
bH 7o
o Pl

o Rz

4 TR1, TR2
i vt
b SrGate
L vempl
;_|-' Dirming Control Black
|4 TR3, TRY
| RS

b APl
|- Exim
o R
iy

4K 1

H c2

| R, BT
L ampz
P P black
4 TRS
b oce

- Pomcp

1

Block.

Dinde:

Dinde:

Resistor, Fixed
Resistor, Fixed
Transistor

IC, Digital

IC, Digital

IC, Analog/Linear
Block.

Transistor
Resistor, Fixed
IC, Analog/Linear
IC, Digital
Resistor, Fixed
Resistor, Fixed
Capacitar
Capacitar
Resistor, Fixed
IC, Analog/Linear
Block.

Transistor

IC, Analog/Linear
IC, Analog/Linear

T o O O NN S S iy

21,7136

1.5265
1.3539
0.1766
0.1926
8.5010
4.1247
4.1247
1.4136
29.6423
13,0810
0.1926
2.8766
44084
0.2497
0.2137
1.3721
1.0866
0.2028
0.9589
42,3572
9.0405
0.9589
0.9589

ol

Propetties
Properties Model
Properties ¥alues =
=l General
Tame Dimmer Controller
D

Part Mumber
Alternate Part Number
Revisian

LCN

Reference Designator
Supplier

Description

Funiction Descripkion

Redundancy
Quantity
Quantity Required
Mission Time (hrs)
Analyst

Compiled By
Approved By

Comments

#l Applicabion

False =

24

=]

You publish the model for the Dimmer Controller system by selecting the system and choosing Prediction
Tools > Share > Publish Item Model.

"
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© XFvMEA @ RCM++ O RBI

You then open this project in Xfmea/RCM++/RBI and change the system hierarchy to include the
Controller and LED Bulb, as shown next.

Name EANE
Il Chandelier
|—8 Frame ry
|—8 Wiring P
_ll-a LED and Controller

] Integrated Dimming LED
Lighting Controller

(L] LED Light
LJ Sockst A =

In the FMRA view, you use the ALTA model that you published to describe the reliability of the LED
light.

=l Reliability Polcy

Type Define at this level -
=l URD LED Light_LIRD
E‘ Model ALTA_Accelerated Degradation - LED Lamp
e [IP' {0,504, 1.054E-41, 17,2031

You use the model from Lambda Predict to describe the reliability of the controller.

=l Reliability Polcy
Type Define at this level -

Integrated Dimming LED Lighting
Controller_URD

E‘ Model LP_Dimmer Controller [EX1 (9, 371E-08)] -

=l URD
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3.14 Testing and Ongoing Product Development

Calculating the FMRA, you see that the reliability estimate for the LED version of the chandelier is about
90.41%, as shown next.

A Syskem Hierarchy ﬂ FMRA

Name ﬁ {_EJ Reliability Policy - (gﬁgfﬂ:i?;)
1@l Chandelier Inherit - 0.904140
23 Frame Tnherit 0993272
_J;r_l-g Wiring Inherit - 0,992525
_ll-g LED and Controller Inherit - 0.917120
0 it oot Hepdsounsls o
|—J LED Light LED Light_URD ] 0,940804
=t | Sockst Inherit ] 0.975283
_ll- ¥| Provide electricity to bulb Inherit - 0.975283
_%_l— #| Fails to make contact Inherit = 0.985100
| F= oirty contacts Dirty contacts ~ [0.995010
‘ L_gj FS;:Sre; connection Solder connection Failure = 0.990040
_ll-L' Shart Inhetit - 0,990035
2 e ot oy Ferdu it = Bs0o4
L_gj Manufacturing Manufacturing - 0,999995

This represents a significant decrease in reliability from the version of the chandelier that uses the
incandescent bulb, which had an estimated reliability of 95.42%. The company decides to shelve the plans
for the LED design temporarily, and you return your focus to the original design.

3.14 Testing and Ongoing Product Development

(Note that the steps described in this section are not visible in the sample project.)

Throughout the rest of the chandelier’s life cycle, you will continue to perform tests and other activities to
quantify and improve the reliability of your product. You will use XFRACAS (a web-based failure
reporting analysis and corrective action system) to record and manage information about new failure
modes and issues that are discovered, as well as about the actual occurrence of failure modes that were
anticipated in the FMEA.

As new information becomes available, you will analyze the data to publish new models and update
existing ones. The data can be obtained from a variety of channels, including testing, field performance
and data sets extracted from XFRACAS. At any time, you can pull data for one or more parts from
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XFRACAS into the Reliability Data Warehouse (RDW). From there, you can transfer the data set into
Weibull++ for life data analysis and/or into RGA for reliability growth analysis.

W XFRACAS to RDW [_ O] x|
Select Parts Main 14

Part Mumber Part Mame Part Yersion *
Entit:
Chandeler | 3 e

=l

Caomposite Frame Eﬂ’ RELIASOFT MODEL DATABASE
Wiring
: FL Bulb and Sockst 3 Status
+ "L ROW o Folio
&}
A &7y set Time Column = I= - #HA o
; __J Set Subset 1D Calumn 1 == t i ¢ =8 _J
LI swsumnctime gy T o Pt L
Data Set I View | CurrentRow | Dashboard |
Export Status Part Mame Part Mumber State Time State FS ::
= "
Included Composite Frame FRC1 5385 5
Included Composite Frame FRC1 2275 5
Irvvalid Composite Frame FRC1 -7E66A3 5
Included Composite Frame FRC1 18961 5
Included Composite Frame FRC1 TFETST F
Irvvalid Composite Frame FRC1 -94240 5
Included Composite Frame FRC1 43799 5
Included Composite Frame FRC1 19965 3
Included Composite Frame FRC1 47013 5
Included Composite Frame FRC1 83482 5
Included Composite Frame FRC1 447 F
Ignored Composite Frame FRC1 u] 3 e
43‘:| Current Data Set: Composite Frame _éB Current Time Colurnn: State Time

You can also use the XFRACAS data to improve the FMEA and maintenance plans. This includes adding
new failure modes that have been observed during testing and/or in the field, as well as improving the
accuracy of occurrence ratings based on the number of times that failure modes actually occurred.

3.15 Maintenance Planning

The system configuration and reliability information that you have developed from prior analyses can
easily be adopted for life cycle cost and maintenance planning in BlockSim and RCM++/RBI. In this case,
you decide to estimate the availability and maintenance costs that your customers are likely to experience
after purchasing and installing your new chandelier. You expect that customers will replace the chandelier
entirely if there are problems with the frame or the wiring. They will replace burned-out bulbs themselves,
but will need to call an electrician for socket issues.
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3.15.1 Defining Reliability Models at the Component/Assembly Level

™. Inthis section, you will switch to the “5. Chandelier - Maintenance Planning Part 1” project in the quick
‘-") start repository, using BlockSim.

For prior analyses, the system hierarchy and the DFMEA went down to specific root causes to determine
actions to improve reliability and to define reliability design targets for specific failure modes. This makes
sense during development. From a reliability-based maintenance perspective, however, information on the
causes or failure modes may need to be less detailed, because the actions to address the failures would be
at a higher level. For example, regardless of what caused the bulb to fail, the entire bulb must be replaced
to restore the system. Addressing causes below the bulb failure level adds no value in this case, as the
resulting action would be identical. Thus, the reliability does not need to be inherited from the underlying
causes, but rather can be defined at the component/assembly level.

So the next step is to assign reliability models for the Frame, Wiring, Bulb and Socket, which can then be
used for maintenance planning. To do this, you return to the same FMRA analysis that you created in
Xfmea/RCM++/RBI, but now you will work with the analysis in BlockSim. Editing the same FMRA in
both applications is like having the same document open in two software windows. Any changes that are
made in one location will be applied to the other when you synchronize the two.

Note: Since they are directly linked, any changes made in the FMRA are also made in the FMEA. For example, if
you delete a block that represents a cause from the FMRA view in BlockSim, this will automatically delete it from
both the FMRA and the associated FMEA in Xfmea/RCM++/RBI. The same holds true when you change properties,
etc. For this reason, it is important to exercise caution in this environment.

If the FMRA tab is not already visible when you open the sample project in BlockSim, choose View >
FMRA > Show FMRA to display it. You can see the that the reliability of the Bulb is now obtained from
the accelerated life testing data analysis that you performed in ALTA, while the reliabilities of the Frame,
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Wiring and Socket are still being “inherited” from the failure mode occurrence models obtained from the

FMEAs.

Name

Reliability Policy

||l Chandelier

=S

Inherit

_l_l-a Frame

_ll- _¥| Hold the Chandelier together

_ll-ﬂ Frame Cracks, Fails

|— =| Corrosion

|_ IMetal Fatigue due ko
3 swinging, cyclical stresses

_—J—a Wiring

=3

¥ | Provide Electricity
__|- | Aging and Stress

—. Deterioration of the
=! insulation

= ®| Bending

| L_gj Tight bend radii

_l_I- ‘#| Chafing

|— =| Swinging and looser wires

=I #| Delamination

|_ — Failure of the bonding
= material

Terminal point connection
failure

che|
Lz =| Frequent manipulation

®| Series Arcing

|_ Loose terminal or crimp,
E corrosion, or dirtin .

;l—a Bulb and Socket
L1 Bub
_ll-J Sockst
_ll- ¥| Provide electricity to bulb
_%_l— #| Fails to make contact
| |—__J Dirty contacks
Solder connection

_—J failure
_I|- #| sShort
}»_ Presence of Foreign
= conductive material
|—__J Manufackuring
4] |
:;';]Standard

7] Inherit
Inherit
Corrasion

IMetal Fatigue due ko
swinging, cyclical stresses

R R R

Inherit
Inherit

Deterioration of the
insulation

Inherit
Tight bend radii
Inherit

Swinging and looser wires

Inherit

Failure of the bonding
material

Inherit

Frequent manipulation
Inherit

Loose terminal or crimp,
corrosion, or dirtin ...

Lg.» RRER R RRRERRR R QR

Inherit

Inherit

Inherit
Dirky conkacks
Solder connection Failure

Inherit

Presence of Foreign
conductive material

R R R RRR

Manufacturing
i
[FFMRA

To obtain a reliability model that can be applied directly to the Frame, you first double-click the item in
the FMRA hierarchy to see its reliability block diagram. Then you analyze the diagram and use the

64
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Distribution Estimator to fit a model that represents the entire assembly. The following picture shows the

results.

Hold the
Chandelier
together

[ESE
Frame_1

O ©

* Distribution Estimator (Frame_ 1)

A

Results valid as of
3212014 11:23:51 AM

Distribution it
2P-Weibull

Distribution

T | il
Eta 25191.050090

Units
|H0ur (Hr) m|

Additional Options |
[ Use Distribution Wizard {does not apply to Mixed Weibull)
[ ] Create Weibull++ data set o

=
=D
Mumber of sampling points 100
| Compute | Update | Cancel

Then you go to the Publishing page of the diagram's control panel and publish this fitted model as a
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Synthesis resource that represents the reliability of the Frame.

i = EN[FS
“)| Publishing 1
[ FVRADAGRAM
. Fitted Model (T
Hold the BlockSim_Frame_1_Fitted
Chandelier h Status Published
L m Linked? Unlinked
ﬁ Synchronized?  Synchronized
Model Name Model Category " Created By E—zgagroggion
BlockSim_Frame_1_Fitted Modified By m
Corporation
Model Basis & Status
Source Frame_1 Analytical Model 0 -
Application BlockSim '; IStatus Unpublished
Type Approximated Diagram EA‘
Status Synchronized 5
Model Definition m
2p-iweibul -
Beta 3.093676 s
Eta 25191.050090
Pnz 1.000000 -
g T T t] Analytical
< T Mumber —
Frame| |- Version EEI 3’ = '51
2 Applies ta
6 Keywords
o Used by 0items |[§ | 1] oK Cancel

You follow a similar process to create and publish models for the Wiring and Socket. (To see these
diagrams in the sample project, double-click each item in the FMRA hierarchy.)

3.15.2 Assigning the Models in the FMRA

In this section, you will switch to the “6. Chandelier - Maintenance Planning Part 2” project in the quick
V> start repository, still using BlockSim.

To use the new published models in the FMRA, you select each item and choose FMRA > Inheritance >
Define at this level. This turns the item from a diagram (in which the reliability was calculated from sub-
items and/or failure modes) into a single block. You then double-click the item to open the block
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properties and assign the published reliability model. The following picture shows the updated FMRA, as
well as the model that has now been assigned to the Frame block.

| Current Project

Name & 2 “Poiey’ ™ (anaivtica)
=I(@@ Chandslier i Inhertt = 0054z
2 Frame Oy Frame URD_ == 0.993272
|—E Wiring ] Wirng_URD 0.992525
_ll-a Bulb and Socket ‘:;g Inherit
L1 Bub 2 Bub_URD
L] socket 7 Socket_URD
& Block Properties
Estandard
Properties Universal Reli}bﬂqxeﬁnition {URD}
& current Prc_ 0 ;||. Block (Standard Block) gﬂ =l [’ URD |Frame_URD ---|
. Project List 2 |—B|0ck name Frame Lh Model - BlockSim_Frame_1_Fitted i
u L _ Relhiability [Hn) ['WEBZ (3.0%4, 2.519E+04)]
r Block description
Mo | fuJ Operation
|—|_ Represents multiple blocks
u% |— Current age 0{Hr
' L Duty cycle 1
§ =l § Consequential Costs
m |—Cost per Failure Default - Mo Cost
3: L Downtime rate ($/Hr)  Default - Mo Cost
1[5 1dentifiers Tt | . ET
Active Block |Fran187_l. | Style J -_:I_:l_- __H @ L | OK . Cancel

3.15.3 Creating the Maintenance Tasks

@ @ In this section, you will continue working with the “6. Chandelier - Maintenance Planning Part 2”
project in the quick start repository, now using RCM++/RBI. Note that this part of the analysis cannot
be performed in Xfmea.

Now that the FMRA has been updated, you return to RCM++/RBI to define the expected maintenance
strategy and calculate the metrics of interest.
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To see the corrective task for the Bulb (“Replace Failed Bulb” task), select the item in the FMRA
hierarchy, click twice in the Corrective Task field and then click the View/Edit icon.

‘ Syskem Hierarchy | Eﬂ FMRA

1=

Name

=@l Chandelier
|—E Frame
|—E Wiring

_ll-g Bulb and Socket

| Bub

LJ Socket

- 6. Chandelier’ = Maintenance Planming Part 2

Sli=es
j Properties |
Property Name Yalue
#| Item
+| Operation
#| Rehiability / Availability
=l Reliability Polcy
Type Define at this level -
=l URD Eulb_URD
h Model ALTA_Bulb Model A14 [IPW (4,419, 3.513E-27, i
At 10.7131]
g Corrective Task |Replace Failed Bulb ILIJI
| History Corrective Task @‘ I
P [Fier | =
f Replace Failed Bulb
j Replace Socket
=l &
lLJ [8]4 . Cancel
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The task properties are as follows:

%: Maintenance Task

Task Name

| Crew Name

‘Owner

| Replace Failed Bulb

Crew Properties

;||‘ Crem

Corrective Properties

)»Dlrect cost (§/Hr)

21| 4 Task Scheduling

}—CUSt per incident

L Start corrective task Upon ikerm Failure
=l -"_4— Basic Repair Properties
|»E‘ Task duration (Hr)
_%]—“ Crew For task
| _1|» Crew (Priority 1)
| L Logistic delay (Hr)
_ll»,:g Spare Part Pool
|—Suares in pool

Replace Bulb Time [NOR (0,083, 0,01

Onner

Bulb Purchase

Unlimited \
L Lodgistic time For spare acquisition (Hr) Trip Time [MOR {2,000, 0.333)]
= ﬂ Task Consequences

| .«‘ Restoration

= % Additional Costs to Consider

" |—C05t per kask Drive Costs [MOR (6,000, 0.500)]
ﬁ B Downtime rate (FiHr) Default - Mo Cost
] | Dﬁ Identifiers
I
' | @ History ‘
2 |
o P
g

Creating new corrective task

e The bulb will be replaced when it fails.

Ladder Retrieval Time [MOR. (0. 167, 0.033)]

SYNTHESIS

)|

}»Lnglstlt delay (Hr)

Ll_ Include part delay in cost
| Dﬂ Identifiers

1= there a limit to the number of
tasks this crew can perform at the
same time?

}»l_ Include logistic delay in cost

Default - No Cost

Default - No Cost

Mo

Ladder Retrigval Time [MOR (0,167,

0,033)]

% Spare Part Pool

| Spare Part Pool Name

‘Eulh Purchase

Spare Part Pool Propetties

;|| = Spares

)»DIFEEE cost per dispensed item

}—Spare acquisition type

L Laogistic bime Far spare acquisition
(Hr)

21 (5] 1dentifiers
| @ History

Bulb Price [NOR (5.000, 0.500)]

Unlimited spares

Trip Time [NOR {2,000, 0.333)]

& G

A

Creating new pool

QK

Cancel

e [t takes an average of 5 minutes with a standard deviation of 1 minute to actually replace the bulb.
This is represented by the “Replace Bulb Time” model.

o The bulb will be replaced by the owner of the chandelier. To see the “Owner” crew properties,
click twice in the Crew (Priority 1) field and then click the View/Edit icon.

o It takes the owner about 10 minutes with a standard deviation of 2 minutes to get the ladder and
set it up. This is represented by the “Ladder Retrieval Time” model.

e The owner does not keep spare bulbs on hand and will have to purchase one from a nearby home
improvement store. To see the “Bulb Purchase” spare part pool properties, click twice in the Spare
Part Pool field and then click the View/Edit icon.

o The cost for the bulb is around $5 with a standard deviation of $0.50. This is represented by the

“Bulb Price” model.
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o The drive time, in-store time and return time for a trip total about 2 hours (120 minutes) with a
standard deviation of 20 minutes, depending on the traffic and how busy the store is. This is

represented by the “Trip Time” model.

e The car expenses (fuel, etc.) to get to the store are about $6.00 with a standard deviation of $0.50.

These costs are represented by the “Drive Co

sts” model.

To see the corrective task for the Socket (“Replace Socket” task), select the item in the FMRA hierarchy,
click twice in the Corrective Task field and then click the View/Edit icon. The task properties are as

follows:

% Mamtenance Task

Task Name

| Crew Name

‘ Replace Socket
E

| ‘Elactrician

Corrective Properties

Crew Properties

l’{) Task Scheduling

]

;||* Crew

L. Start corrective task Upan item Failure

=l -‘li Basic Repair Properties
H‘ Task duration (Hr)
_lrl-* Crew For task

i
‘ =} Crew (Priority 1)

Replace Socket Time [NOR (1,000, 0,333)]

Electrician
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e [t takes an average of 60 minutes (with a standard deviation of 20 minutes) to perform the socket
replacement. This is represented by the “Replace Socket Time” model.
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3.15 Maintenance Planning

e [f the socket fails, an electrician needs to be called. To see the “Electrician” crew properties, click
twice in the Crew (Priority 1) field and then click the View/Edit icon.

o On average, it takes 4 days with a standard deviation of 1 day for the electrician to arrive after
the owner calls to schedule an appointment. This is represented by the “Electrician Scheduling

Delay” model.

o The electrician will charge $90 per hour, represented by the “Electrician Cost per Hour” model,

plus a fixed fee of $50 per call, represented by the “Electrician Cost per Call” model.

e The electrician may or may not have a spare socket available. To see the “Socket Part” spare part

pool properties, click twice in the Spare Part Pool field and then click the View/Edit icon.

o There is a $50 charge for the spare socket that will be used for the repair. This is represented by

the “Socket Price” model.

o There is also a 50% chance that the electrician will not have a spare socket available. This is set
by choosing Fixed probability of stockout in the Spare acquisition type field and entering

0.5 in the Fixed probability value field.

o If no socket is available, the electrician will drive to a nearby home improvement store (the
same store where the owner buys spare bulbs) to purchase one. This is represented by the “Trip

Time” model.

You want to know the system availability and associated costs, assuming a use of 5,000 hours. To show
the Simulation Results Status, Operating Cost and Availability columns in the FMRA, right-click a

column header and click Customize Columns.

You simulate the FMRA using an Operation Time of 5,000 hours (running 2,000 simulations, using a

starting seed of 1 and a single thread).

A Syskem Hierarchy Ea FMRA

| Reliability __ ' Reliability __  Operating e
fame ﬁ =] Policy ~  (Analytical) ~— Cost Qasilability
| (@l Chandslier %71 Inherit == 0954222 o { 2.833695 ) { 0.995999)
2 Frame ) Frame URD == | 0.993272 | == o 0,995742
3 wiring ) wirng_URD == | 0892525 | mw 0 0997640
=3 Bub and Sacket ) Inherit == 0967921 | == 2533695 0999617
L1 Bub ) Bulb_URD == 0992451 0046774 0999998

L] sacket %) Socket URD == 0975283  mw 2786921 | 0,999519

You see that the projected system availability is approximately 99.60%, and the projected operating cost is

$2.83.
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RELIASOFT CORPORATION END-USER LICENSE
AGREEMENT

This ReliaSoft Corporation End-User License Agreement is a legal agreement between You and ReliaSoft
Corporation for ReliaSoft Corporation's software products, which includes computer software and associated
media and printed materials as well as on-line or electronic documentation and any software updates or
upgrades, henceforth collectively called the “Application.”

By installing, copying or otherwise using the Application, You agree to be bound by the terms of this End-User
License Agreement and represent and warrant that You are authorized to do so. If You do not agree to the
terms of this End-User License Agreement, do not install or use the Application and promptly return the
Application to the vendor from which you obtained it within fourteen (14) calendar days from the date of
purchase for a full refund.

This Agreement is effective from the earlier of the date You open the sealed software package, if applicable, or
install the Application, or fourteen (14) calendar days from the date the Application was purchased or otherwise
obtained from ReliaSoft Corporation, and continues until expressly terminated by ReliaSoft Corporation.

This Application is protected by copyright laws and international copyright treaties, as well as other intellectual
property laws and treaties. This Application is licensed, not sold.

1 DEFINITIONS

1.1 Access. Means connected to or using the Application in any manner, either directly or
indirectly through any middle tier application or system.
1.2 Activate. Means the act of enabling the Application to operate on a specific computer by

registering the Application license with the ReliaSoft License Server and activating the
Application for operation.

1.3 Location. Means the postal address of the site where the Application shall be installed.
Location shall mean a single physical location.

14 Named User(s). Means the individual(s) permitted to Access the Application, and it refers
to specific individuals.

1.5 ReliaSoft License Server. Means the ReliaSoft server(s) that provides license activation,

registered end-user management, license management and license compliance
enforcement services for the Application.

1.6 You. Means the licensee or the individual acquiring the license of this Application and, in
either case, the affiliates, employees, contractors and agents of said licensee or individual.

2 LICENSE GRANT

241 Grant. Subject to the license types defined in Section 3 hereof, You are granted a personal,
non-exclusive and limited license to install, Activate and Access the Application under the
license type and in the quantities for which You have obtained a license. You may install
and Activate the Application onto designated equipment at the specified Location(s), solely
as necessary to use the Application in accordance with this Agreement. You may not
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distribute, sublicense, copy (except as expressly permitted in this Agreement), transfer
(except as expressly permitted in this Agreement), nor give the Application to any third
party.

Ownership. The Application and the information it contains, including any updates,
upgrades, modifications and derivative works, and all copies of them, are the property of
ReliaSoft Corporation (or its licensors), and title remains with ReliaSoft Corporation (or
ReliaSoft Corporation's licensors). All applicable rights in patents, copyrights and trade
secrets in the Application are and will remain with ReliaSoft Corporation (or ReliaSoft
Corporation’s licensors). No title to, or ownership of, the Application or the information
contained therein is transferred to You. ReliaSoft Corporation reserves all rights not
explicitly granted in this Agreement.

Rights to Developments. This Agreement also governs your use of any enhancements,
data, or information provided by ReliaSoft Corporation while performing any technical,
training or consulting services. Any ideas, know-how, techniques and software developed
by ReliaSoft Corporation, including any enhancements or modifications made to the
Application by any person, are the property of ReliaSoft Corporation.

INSTALLATION AND USE

ReliaSoft Corporation licenses any Application under this Agreement on a per user basis. In other
words, ReliaSoft Corporation licenses an Application to each user and not to a particular computer.
This Agreement grants You the following rights, depending on the license You have obtained from
ReliaSoft Corporation:

3.1

3.2

Single User License. The Single User License is licensed to one individual Named User.
This is a perpetual license. Each software package includes the installation media and one
copy of the Application documentation per license, either in physical/hard copy format
and/or electronic format. The Named User may install, Activate and Access the Application
on up to three computers (i.e., multiple Locations), such as a work computer, a home
computer and a portable computer, provided that the Named User is the only person who
uses this Application, at any time, in any of these Locations. In the event that installation
and activation of the Application is performed on three computers, the Named User will be
required to deactivate at least one installation before being allowed to Activate the
Application again. There is a limit of 6 activations allowed per calendar year. The Single
User License cannot be installed on multi-user capable environments such as Windows,
Terminal or Citrix servers.

Use of the Application on any of the computers by any user other than the Named User who
has licensed the Application is strictly prohibited. Such other users must obtain a separate
license of the Application from ReliaSoft before any use.

Standard Network License. The Standard Network License is licensed to Named Users in
an organization on a single network of computers at a specified Location. This is a
perpetual license. The software package includes the installation media and one copy of the
Application documentation per license, either in physical/hard copy format and/or electronic
format. Note: This is not a Concurrent Network License.
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This license provides for a limited number of Named Users, dependent on the quantity of
seats licensed, to install, Activate and Access the Application, with a single activation
allowed for each Named User. For example, if You purchase a ten (10) seat Standard
Network License, only ten (10) specific Named Users are allowed Access. If an eleventh
(11t) user wishes to have Access to the Application, an additional seat must be licensed. In
the event that installation and activation of the Application is required on a new computer for
a Named User, the Named User will be required to deactivate the active installation before
being allowed to install and Activate the Application on the new computer. The Standard
Network License allows for installation on multi-user capable environments such as
Windows, Terminal or Citrix servers.

Under this license, no other copies can be installed on non-network computers, such as
portable computers, home computers, etc.

Concurrent Network License. The Concurrent Network License is licensed to an
organization with multiple regular and occasional Named Users on a single network of
computers at a specified Location. This is a perpetual license. The software package
includes the installation media and one copy of the Application documentation per license,
either in physical/hard copy format and/or electronic format. Concurrent Network Licenses
are specified by two attributes:

(i)  Number of Named User Activations, which is the maximum number of computers on
which a Named User can Activate the Application (i.e., make it available for operation).
More than one activation is allowed for each Named User (e.g., to install the
Application on both a work computer and a portable computer), but each activation is
counted toward the maximum available under the license.

(i)  Number of Concurrent Access Licenses (or CALs), which is the maximum number of
computers that can Access the Application at any given time.

For example, for a Concurrent Network License with thirty (30) Named User Activations and
ten (10) CALs, the Application can be installed and activated on up to 30 computers (e.g.,
by 30 Named Users each activating the Application on only one computer, by 15 Named
Users each activating the Application on two computers, etc.), and only ten (10) of those
computers will be able to Access the Application at the same time. If a user attempts to
Access the Application from an eleventh (11th) computer, the user must wait until one of the
other ten users ends their session and releases the CAL. The Concurrent Network License
allows for installation on multi-user capable environments such as Windows, Terminal or
Citrix servers.

Under this license, Named Users are allowed to check out a CAL from the ReliaSoft
License Server for a specified period of time, effectively being guaranteed Access to the
Application while simultaneously reducing the number of available CALs for the rest of the
user pool until the CAL is checked back into the ReliaSoft License Server or otherwise
released. This ability to check out a CAL from the ReliaSoft License Server is only available
for Applications designated as Major Version 8 and above (e.g., 8.0.1, 8.0.2, etc).

This type of license requires that you provide/allow internet access from the Application to
the ReliaSoft License Server at https://Validate.ReliaSoft.org. Concurrency authorization
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3.5

3.6

and control is managed and provided by this server. You may need to modify and adjust
your internet and/or firewall settings and/or set the aforementioned server as a trusted
location in order to use the Application. This requirement for connectivity to the ReliaSoft
License Server for concurrency authorization and control only applies for Applications
designated as Major Version 8 and above (e.g., 8.0.1, 8.0.2, etc).

Asset-based License (only applies to Orion eAPI software). The Asset-based License is
licensed to all direct employees of a corporate entity within one or more specified Sites,
depending on the license obtained. This license excludes subcontractors, suppliers or
temporary employees, unless they are using the Application inside an eligible Site on a
computer owned by that Site. This is a perpetual license.

Under this license, an unlimited number of Named Users from the licensing Site or Sites is
allowed to Access the Application; however, the license restricts the number of physical
assets (commonly referred to as Asset TAGs) that can be configured and managed within
the Application. For this license, a Site is defined as a distinct physical address/site of a
corporate entity, where the physical assets being managed reside (e.g., a refinery or a mine
or a power station). The license specifically excludes broader geographical areas, such as
cities or states/provinces (where multiple Sites might exist).

Unlimited User License. The Unlimited User License is licensed to all direct employees of
a corporate entity within a specified Site, Division, or Corporation, depending on the type of
license obtained. This license excludes subcontractors, suppliers or temporary employees,
unless they are using the Application inside an eligible facility on a computer owned by that
facility. This is a perpetual license.

Site-Wide License: Covers all direct employees working at a distinct physical address/site of
a corporate entity. A Site-Wide License specifically excludes broader geographical areas,
such as cities or states/provinces (where multiple sites might exist).

Division-Wide License: Covers all direct employees affiliated with a unique business unit of
a corporate entity organized in multiple divisions/business units. Examples of divisions are
the Aerospace Division of a large conglomerate or the Brakes Division of an automotive
corporation. A Division-Wide license might additionally be restricted to a specific
geographical area to facilitate licensee requirements (for example, the Aerospace Division
of a conglomerate in North America).

Corporate-Wide License: Covers all direct employees of a corporate entity.

This license entitles the specified corporate entity at the specified Site/Division/Corporation
to make and distribute copies of the Application in executable code in its entirety, as
supplied by ReliaSoft Corporation, OR install and distribute the Application over a network.
The software package includes the installation media and one copy of the Application
documentation per license, either in physical/hard copy format and/or electronic format. The
Unlimited User License allows for installation on multi-user capable environments such as
Windows, Terminal or Citrix servers.

Rental License. Rental licenses are available for the Single User, Standard Network and
Concurrent Network licenses. The license terms are the same as the corresponding license



type being rented except that the license expires according to the term purchased. The
rental fee will not be prorated or refunded if license rental is cancelled or not used in full. A
standard non-expiring license may be purchased at any time at the current Application list
price.

3.7 Evaluation, Demo, No Save Demo, Beta, or Otherwise Expiring or Non-Expiring
Licenses of any Type Provided for Evaluation Purposes. These are Evaluation/Not for
Sale licenses and, notwithstanding any other section of this Agreement, You may not use
the Application for commercial purposes, nor sell or otherwise transfer it for value.
“Commercial purposes” include the use of the Application in creation of publicly distributed
computer software. You are acquiring only the limited right to use a single copy of the
Application solely for evaluation purposes and for a limited time. ReliaSoft Corporation can
terminate this Agreement at any time. You have no rights under any sections of this
Agreement other than those specifically allowed for within this section (Section 3.7). THE
APPLICATION IS LICENSED AS IS with no representations or warranties of any kind.
Note: As the section title implies, users of any license provided by ReliaSoft Corporation for
evaluation purposes (even if it is, for example, a Single User or Network License), shall
abide by the rules set forth in this section.

3.8 Complimentary License. Complimentary Licenses have the same installation and use
rights as their corresponding purchased licenses (e.g., a Complimentary Single User
License provides the same installation and use rights as the Single User License).
However, You have no rights under any other sections of this Agreement other than those
specifically allowed for within this section (Section 3.8). THE APPLICATION IS LICENSED
AS IS with no representations or warranties of any kind and license transfers are NOT
allowed.

Regardless of the license type You have obtained from ReliaSoft Corporation, You may access
shared data storage files or databases relating to the Application across a wide area network (WAN)
or a virtual private network (VPN), instead of a local area network (LAN), as long as such access is
permitted by your policies and authorized by You via appropriate Application and network
configuration settings. Although such access is not prohibited by ReliaSoft Corporation, you
acknowledge that WAN and VPN data transfer rates vary widely and could lead to decreased and
unpredictable performance (as compared to a LAN) and therefore disclaim any expectation of
Application performance should you choose to a) configure any part of the Application, b) use the
Application, or c) access shared data storage files in a distributed environment over a WAN or VPN.
Such disclaimer does not apply to any Application designated and licensed as a native Web-based
Application by ReliaSoft Corporation.

SOFTWARE TRANSFERS

41 Single User License. You may permanently transfer all of your rights related to a Single
User License under this Agreement, provided that You retain no copies, You transfer all of
the Application (including all component parts, media, printed or electronic materials, any
upgrades and this Agreement) and the transferee agrees to the terms of this Agreement. If
the Application is an upgrade, any transfer must include all prior versions of the Application.
Single User License transfers are only allowed between Named Users of the same
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organization (i.e., transfers are not allowed across different organizations). The Named
User transferring the Application must deactivate any and all active installations of the
Application before the transferee can Activate the Application. A Single User License may
not be transferred more than two times in a calendar year. This section also applies to
Single User License Rentals.

Standard Network, Concurrent Network, Asset-based and Unlimited User Licenses.
Standard Network, Concurrent Network, Asset-based and Unlimited User licenses are NOT
transferable across organizations, and licensing rights CANNOT be split or transferred
between multiple organizations in cases of corporate acquisitions or divestitures, except as
allowed in items (a) and (b) of this section (Section 4.2), and with ReliaSoft Corporation’s
written consent.

In the case of Standard and Concurrent Network Licenses, Named User Activations can be
deactivated and replaced by new users on a permanent basis. In other words, replacement
of users is allowed to accommodate attrition and reassignment of user responsibilities in the
ordinary course of doing business. However, replacing users on a daily, weekly, monthly or
even quarterly basis and frequently reactivating users that were previously replaced is an
indication that the number of Named Users (for Standard Network Licenses) or Named
User Activations (for Concurrent Network Licenses) obtained by You is not adequate to
serve the pool of users intending to Access the Application and is therefore prohibited. Each
Standard Network License seat or Concurrent Network Named User Activation can be
reassigned to a different Named User no more than two times in a calendar year.

In cases of corporate acquisitions or divestitures: (a) Standard Network and Concurrent
Network licenses remain with the organization that originally obtained the licenses, (e.g., if
the organization that holds the license is acquired by another entity, the licensing rights will
be transferred to the acquiring entity); (b) Unlimited Site-Wide licenses remain with the
original licensing site and therefore pass on to the owner of the specific licensing site as
long as the site continues to exist; (c) Unlimited Division-Wide licenses remain with the
organization that originally obtained the licenses in cases where the Division is being
partially divested, and are terminated when the Division is fully divested. As an example, in
a partial divestiture, the portions of the Division divested will not have access to the
Division-Wide license whereas the portions of the Division that remain will continue to have
access to the Division-Wide license; and (d) Unlimited Corporate-Wide licenses remain with
the organization that originally obtained the licenses as long as said organization divested a
portion of its business or acquired other organizations, and are terminated in cases where
said organization was acquired by another organization. As an example, in a partial
divestiture, the portions of the corporation divested will not have access to the Corporate-
Wide license whereas the portions of the corporation that remain will continue to have
access to the Corporate-Wide license. As a further example, an organization with a
Corporate-Wide license having acquired other entities (either in part or in whole) will
continue to have the same licensing rights as before the acquisition and can therefore
deploy the same licensing rights to the newly acquired entities.

This section also applies to Standard Network and Concurrent Network License Rentals.
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Limitations on Reverse Engineering, Decompilation and Disassembly. You may not
reverse engineer, decompile or disassemble the Application. You shall not provide, disclose
or otherwise make available the Application, in any form, to any person other than your
employees and under your direction and control for purposes specifically related to your
permitted use of the Application. You will not: (a) alter, modify or prepare derivative works
of the Application; (b) transmit the Application electronically by any means; or (c) cause or
permit the translation, reverse engineering, disassembly, or decompilation of the Application
to determine any design structure, source code, concepts and methodology behind the
Application, whether to incorporate it within any product of your own creation, create a
derivative work, create any product that is competitive with the Application or other
ReliaSoft Corporation products, or for any other purpose.

Copyright. All title and copyrights to the Application are owned by ReliaSoft Corporation (or
its suppliers or licensors). The Application is protected by copyright laws and international
treaty provisions. Therefore, You must treat the Application like any other copyrighted
material except that You may make one copy of the media solely for backup or archival
purposes.

Proprietary Notices. All title, trademarks, copyrights and intellectual property rights in and
pertaining to the Application (including but not limited to any copies thereof, software
structure and organization, source code, images and new releases) are valuable property of
ReliaSoft Corporation and are owned or licensed by ReliaSoft Corporation. You may not
intentionally remove, alter or destroy any form of copyright and trademark notices,
proprietary markings or confidential legends placed upon or contained within the
Application, including but not limited to any such notices contained in physical and/or
electronic media or documentation, in the Application interface boxes, or in any of the
runtime resources, code or other embodiments originally contained in or dynamically or
otherwise created by the Application.

Use of ReliaSoft Corporation’s Marks. You may not use the name, logos, trade names or
trademarks of ReliaSoft Corporation or any of its affiliates in any manner including, without
limitation, in your advertising, promotional literature or any other material, whether in
written, electronic, or other form distributed to any third party, except in the form provided by
ReliaSoft Corporation and then solely for the purposes of identifying your use of the
ReliaSoft Corporation Application.

Verification. You will provide, on ReliaSoft Corporation’s reasonable written request,
written verification that the Application is being used according to the terms of this
Agreement. Upon thirty days prior written notice, if ReliaSoft Corporation has reasonable
grounds to believe that this Agreement has been breached, ReliaSoft may audit your use of
the Application provided such audit is: (a) limited to records relating solely to the Application
necessary to verify compliance with the terms of this Agreement; (b) performed by a
reputable independent third party auditor acceptable to You (acting reasonably); (c) the
third party auditor shall comply with your standard security policies; (d) the third party
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auditor shall execute your standard protective non-disclosure agreement; and (d) the cost of
any requested audit will be solely borne by ReliaSoft Corporation if no breach is found as a
result of the audit or will be solely borne by You if a breach is found. Such audit shall occur
no more than once every twelve months and shall not unreasonably interfere with your
normal business operations.

Modification. ReliaSoft Corporation reserves the right to modify or enhance the Application
without obligation to notify You of such changes or to furnish them to You, unless otherwise
agreed upon with a separate agreement (such as an annual maintenance agreement).

Copying. You may not, under any circumstances, copy the Application, in whole or in part,
except as expressly provided under the Copyright section above.

Separation of Components. The Application is licensed as a single product. lts
component parts may not be separated for use on more than one computer.

Rental or Other Exploitation. You may not publish, sub-license, re-license, assign, sell,
distribute, license, transfer, rent, lease or lend the Application to any party, except transfer
the Application as expressly provided under the Transfer section above. If you received any
revenues from the unlawful distribution of the Application, such revenues will be forfeited to
ReliaSoft Corporation.

Fees. You will pay ReliaSoft Corporation all fees or other amounts due under this
Agreement, plus any and all applicable taxes, within the payment term due date specified
on the respective invoice. In the event that the respective invoice is not paid on time, or at
all, ReliaSoft Corporation reserves the right to terminate this Agreement and revoke the
corresponding licenses issued to You within the scope of this Agreement.

Termination. Without prejudice to any other rights, ReliaSoft Corporation may terminate
this Agreement if You fail to comply with the terms and conditions of this Agreement and
such breach is not cured within thirty days of notice of such breach. In such event, You
must destroy all copies of the Application and all of its component parts. Additionally, You
may be held liable for any damage or loss of profit caused to ReliaSoft Corporation arising
from unauthorized use or duplication of this Application.

Supplemental Licenses. If, after the effective date of this Agreement, You subsequently
purchase additional licenses of the Application, these supplemental licenses will be
included under this Agreement.

Press Releases. As part of this Agreement, You acknowledge that ReliaSoft Corporation
may make reference to You as a customer of ReliaSoft Corporation in press releases,
advertising and promotional materials, and You consent to any such reference. ReliaSoft
Corporation will NOT disclose any further details beyond referring to You as a customer
without prior written consent, not to be unreasonably withheld.

Relationship. You and ReliaSoft Corporation are independent contractors and neither is an
agent, joint venture partner, partner or employee of the other, and ReliaSoft Corporation will
not be obligated by any agreements or representations made by You to any person, nor
with respect to any other action by You, nor will ReliaSoft Corporation be obligated for any
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damages to any person, whether caused by your actions, failure to act, negligence or willful
conduct.

Upgrades. If the Application is an upgrade from another product, whether from ReliaSoft
Corporation or another supplier, You may use or transfer the Application only in conjunction
with that upgraded product, unless You destroy the upgraded product. If the Application is
an upgrade of a ReliaSoft Corporation product, You may use the upgraded product only in
accordance with this Agreement. If the Application is an upgrade of a component of a
package of software programs that You licensed as a single product, the Application may
be used and transferred only as part of that single product package and may not be
separated for use on more than one computer.

U.S. Government Restricted Rights. The Application was developed at private expense.
No portion of the Application was developed with government funds and the Application is a
trade secret of ReliaSoft Corporation for all purposes of the Freedom of Information Act.
The Application and documentation are provided with RESTRICTED RIGHTS. Use,
duplication or disclosure by the Government is subject to restrictions as set forth in
subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at
DFARS 252.227-7013 (or its successor) or subparagraphs (c)(1) and (2) of the Commercial
Computer Software Restricted Rights at 48 CFR 52.227-19 (or its successor), as
applicable. Manufacturer is ReliaSoft Corporation, 1450 S. Eastside Loop, Tucson, Arizona
85710, USA.

Limited Warranty. ReliaSoft Corporation warrants that: (a) the Application will perform
substantially in accordance with the accompanying written materials, and on machines
meeting the published minimum requirements, for a period of sixty (60) days from the date
of receipt; and (b) any media on which the Application is furnished will be free from defects
for a period of sixty (60) days from the date of receipt. Some states and jurisdictions do not
allow limitations on duration of an implied warranty, so the above limitation may not apply to
You; in such states and jurisdictions the liability of ReliaSoft Corporation shall be limited to
the minimum extent permitted by law. To the extent allowed by applicable law, implied
warranties on the Application and media, if any, are limited to sixty (60) days; and (c) at the
time of installation, the Application will be free from any mechanism, feature or any other
codes or instructions that: (i) cause the Application to remotely transmit information to
ReliaSoft or any third party, except to communicate with one of ReliaSoft's servers to
facilitate specific functions of the Application (such as to communicate with the ReliaSoft
License Server, access the online help files, etc.); or (i) may be used to permit Access to,
or use of, the Application or computer system on which the Application is loaded, or to
which the Application is linked, by ReliaSoft or any third party.

Customer Remedies. ReliaSoft Corporation's and its suppliers' or licensors’ entire liability
and Your exclusive remedy shall be, at ReliaSoft Corporation's option, either (a) return of
the fee paid for the Application, or (b) repair or replacement of the Application or media that
does not meet ReliaSoft Corporation's Limited Warranty and which is returned to ReliaSoft
Corporation with a copy of your receipt or invoice. Any replacement Application or media
will be warranted for the remainder of the original warranty period or thirty (30) days,
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whichever is longer. None of these remedies nor any product support services offered by
ReliaSoft Corporation are available without a valid License Certificate issued by ReliaSoft
Corporation.

Warranty Exclusions. The Limited Warranty is void if the damage or defect has resulted
from accident, abuse or misapplication. Any modification of the Application by any person
other than ReliaSoft Corporation shall void this warranty. Any manipulation of the
Application’s data storage infrastructure or direct storage of data into the Application’s data
storage from outside the Application by any person other than ReliaSoft Corporation or
ReliaSoft Corporation’s authorized representative shall void this warranty. The warranties in
this section extend only to You and are contingent upon proper use of the Application. The
warranties will not apply to any failure caused by (a) accident, (b) unusual physical,
electrical or electro-magnetic stress, (c) negligence, (d) misuse, (e) failure of electrical
power, air conditioning or humidity control, (f) use of the Application with any equipment or
software not reflected in ReliaSoft Corporation’s specifications, (g) installation, alteration or
repair of the Application by anyone other than ReliaSoft Corporation or ReliaSoft
Corporation’s authorized representative, or (h) or installation on equipment on which the
original identification marks have been removed or altered.

No Other Warranties. No oral or written information or advice given by ReliaSoft
Corporation, its suppliers, dealers, distributors or agents shall create a warranty or in any
way increase the scope of the Limited Warranty, and You may not rely on any such
information or advice as a warranty.

Use of Results Provided By the Application Disclaimer. You understand that the results
provided by the Application cannot replace judgment required for important decisions. Use
of the results provided is done completely at your own risk. ReliaSoft Corporation does not
warrant that the functions of this Application will meet your requirements or be error free.
You assume all risk of the use, quality and performance of the Application, and You are
advised to use your own discretion and judgment regarding the use of the Application.

RELIASOFT CORPORATION, ON BEHALF OF ITSELF AND TS LICENSORS,
DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE, WITH REGARD TO THE APPLICATION. IN NO EVENT
SHALL RELIASOFT CORPORATION OR ITS SUPPLIERS OR LICENSORS BE LIABLE
FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES
WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF
BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION
OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO
USE THE APPLICATION, EVEN IF RELIASOFT CORPORATION HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES. USE OF THIS APPLICATION IS DONE
COMPLETELY AT YOUR OWN RISK, INCLUDING THE USE OF RESULTS PROVIDED
BY THIS APPLICATION. RELIASOFT CORPORATION'S LIABILITY HEREUNDER
SHALL BE LIMITED TO PHYSICAL DAMAGE DIRECTLY CAUSED BY THE SOLE
NEGLIGENCE OF RELIASOFT CORPORATION AND SHALL NOT EXCEED THE PRICE
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PAID FOR THE SOFTWARE PRODUCT. NOTWITHSTANDING ANYTHING HEREIN TO
THE CONTRARY, THE FOREGOING DISCLAIMER AND LIMITATION OF LIABLITY
SHALL NOT APPLY TO RELIASOFT CORPORATION'S OBLIGATIONS UNDER ANY
CLAIM OF INFRINGEMENT AS DESCRIBED IN SECTION 5.28 OF THIS AGREEMENT.

Venue. Venue for any proceedings arising out of or relating to this Agreement shall be in
Tucson, Pima County, Arizona. The parties disclaim the application of the United Nations
Convention on Contracts for the International Sale of Goods. This Agreement is governed
by the laws of the State of Arizona, USA, without reference to conflict to law principles.
Each party to this Agreement submits to the exclusive jurisdiction of the state and federal
courts in the State of Arizona for the purpose of resolving any disputes arising under or
relating to this Agreement. Each party waives any jurisdictional, venue or inconvenient
forum objections to such courts.

Legal Expenses. If legal action is taken by either party to enforce this Agreement, all costs
and expenses (including reasonable attorney fees) incurred by the prevailing party in
exercising any of its rights or remedies or in enforcing any of the terms, conditions, or
provisions of this Agreement will be paid by the other party.

Force Majeure. ReliaSoft Corporation will not be responsible for delays or failures in its
performance due, in whole or in part, to any cause beyond its reasonable control.

Export Control. Regardless of any disclosure made by You to ReliaSoft Corporation of an
ultimate destination of the Application, You will not export, either directly or indirectly any
Application without first obtaining all licenses required, from the U.S. Department of
Commerce or any other agency or department of the United States Government, and
complying with the applicable laws. Neither the Application nor any direct product thereof
may be exported, directly or indirectly, in violation of applicable export laws, or may be used
for any purpose prohibited by these laws including, without limitation, nuclear, chemical or
biological weapons proliferation. ReliaSoft Corporation will provide You with all reasonable
information requested by You in connection to exporting the Application, including providing
You with the U.S. Export Controls Classification Number (ECCN) for the Application.

Waiver. The waiver by either party of any breach of this Agreement shall be in writing and
shall not constitute a waiver of any other or subsequent breach. No waiver of any of the
provisions of this Agreement will be deemed, or will constitute, a waiver of any other
provision, whether or not similar, nor will any waiver constitute a continuing waiver. The
failure by a party to enforce any provision of this Agreement will not be deemed a waiver of
future enforcement of that or any other provision.

Indemnification. You will indemnify and hold ReliaSoft Corporation harmless against any
and all claims, damages, losses, costs or other expenses (including reasonable attorney
fees) that arise directly or indirectly from your breach of this Agreement. ReliaSoft
Corporation shall defend, indemnify and hold harmless, at its own expense, You and your
assigns, successors, directors, officers and employees (each an “Indemnified Party”)
against any and all claims incurred by or made against an Indemnified Party by a third party
in connection with a claim, suit or action which is based on an allegation that the Application
when used by You as authorized under this Agreement, misappropriates or infringes any
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third party patent, copyright, trade secret or other intellectual property right (each, a “Claim”)
provided that ReliaSoft Corporation shall have received from the Indemnified Party: (i)
notice of such Claim as soon as possible after You receive notice of the Claim; given that a
failure to provide notice shall only relieve ReliaSoft Corporation of its indemnity obligation to
the extent ReliaSoft Corporation was prejudiced by such failure; (ii) the exclusive right to
control and direct the investigation, defense or settlement of such claim; and (i) all
reasonable necessary cooperation by You. If your use of any of the Application is, or in
ReliaSoft Corporation’s opinion is likely to be, enjoined due to a Claim, ReliaSoft
Corporation may, at its sole discretion: (a) modify the Application so that it becomes non-
infringing, provided such modifications result in software with substantially similar
functionality and performance; (b) procure for You the right to continue using the Application
under substantially the same terms and conditions as provided for hereunder; or (c) if (a)
and (b) are commercially impracticable, terminate the Agreement and refund to You the
license fee paid by You for the Application which is the subject of the Claim as reduced to
reflect a three-year straight-line depreciation from the applicable license purchase date. The
foregoing indemnification obligation of ReliaSoft Corporation shall not apply: (1) if the
Application is modified by any party other than ReliaSoft Corporation and such modification
was not authorized in writing by ReliaSoft Corporation, but solely to the extent the alleged
infringement is caused by such modification; or (2) to any release of the Application other
than the most current release, provided that: (1) the most current release was either made
available at no cost to You and () You had a commercially reasonable period of time (not
to exceed 60 days) after availability of the current release to implement the current release
so as to avoid the infringement claim. This section (Section 5.28) sets forth ReliaSoft
Corporation’s sole liability and your sole and exclusive remedy with respect to any claim of
infringement.

Equitable Relief. You acknowledge and agree that, due to the unique nature of the
Application, there can be no adequate remedy at law for any breach of your obligations
under this Agreement, that any such breach may allow You or third parties to unfairly
compete with ReliaSoft Corporation resulting in irreparable harm and therefore that, upon
any such breach or threat thereof, ReliaSoft Corporation shall be entitled to injunctive and
other appropriate equitable relief in addition to whatever remedies it may have at law.

Entire Agreement; Amendments. This Agreement is the complete and exclusive
statement of the agreement between the parties and supersedes all prior agreements and
communications with respect to the subject matter, and there are no oral representations,
understandings or agreements that are not fully expressed herein. Any terms appearing on
any order or other form used by You which modify or conflict with the terms and conditions
set forth herein are expressly rejected. Except for the purpose of negating implied
warranties, no course of prior dealings between the parties and no usage of the trade shall
be relevant to supplement or explain any term used in this Agreement. No ReliaSoft
Corporation employee other than an officer of ReliaSoft Corporation (Vice President and
above) shall have any actual or apparent authority to modify the terms of this Agreement in
any way. All amendments shall be in writing and signed by the authorized representative of
ReliaSoft Corporation.
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Severability. If any one or more of the provisions of this Agreement shall for any reason be
held to be invalid, illegal or unenforceable in any respect, any such provision shall be
severable from this Agreement, in which event this Agreement shall be construed as if such
provision had never been contained herein.

Electronic Signatures. ReliaSoft Corporation and You agree that this Agreement may be
executed electronically and that electronic copies of this Agreement shall be binding upon
the parties to the same extent as manually-executed copies.
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